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Computerens
diagnosticeringsfunktioner

HP Insight Diagnostics

% HP Insight Diagnostics leveres kun pa cd til nogle computermodeller.

Hjalpeprogrammet HP Insight Diagnostics ggr det muligt at fa vist
oplysninger om computerens hardwarekonfiguration og udfgre
diagnosteringstest for hardwaren pa computerens undersystemer.
Programmet forenkler identificeringen, diagnosticieringen og
udpegningen af hardwareproblemer.

Fanen Survey vises, nar du &bner HP Insight Diagnostics. Fanen viser
computerens aktuelle konfiguration. Fra fanen Survey har du adgang
til forskellige typer oplysninger om computeren. Andre faner indeholder
yderligere oplysninger, herunder indstillinger for diagnosticeringstesten
og testresultater. Oplysningerne 1 hvert skeermbillede i programmet
kan gemmes som en HTML-fil og lagres pa en diskette eller med en
USB HP-drevkode.

Brug HP Insight Diagnostics til af finde ud af, om alle de enheder, der
er installeret pa computeren, bliver genkendt af systemet og fungerer
korrekt. Det er valgfrit, om du vil kgre en test efter installation eller
tilslutning af en ny enhed, men det anbefales.

Du skal kgre test, gemme testresultaterne og udskrive dem, sa du har
udskrevne rapporter parat, nar du ringer til kundesupportcentret.

% Tredjepartsenheder kan ikke registreres af HP Insight Diagnostics.

Vejledning til fejlfinding
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Abning af HP Insight Diagnostics

Start cd’en Dokumentation og diagnose, sidan som det er beskrevet
nedenfor, for at fa adgang til HP Insight Diagnostics.

1. Nar computeren er teendt, skal du legge cd’en Dokumentation
og diagnose i et optisk drev pa computeren.

2. Luk operativsystemet, og sluk computeren.

3. Tend computeren. Systemet startes fra cd’en.

Hyvis systemet ikke startes fra cd’en i det optiske drev, skal du muligvis
@ndre startrekkefglgen i hjelpeprogrammet til computerops®tning
(F10), sa systemet forsgger at starte det optiske drev, fgr det starter
harddisken. Se Vejledning til computeropscetning (F10) pa Dokumentation
og diagnose-cd’en for at fa yderligere oplysninger.

4. Nar du bliver bedt om det, skal du trykke pa tasten Y, hvis du vil
arbejde i fejlsikret tilstand, eller en anden tast, hvis du vil arbejde
i normal tilstand.

Normal tilstand er standard, hvis du ikke trykker pa nogen taster
inden for det angivne tidsrum. Hvis skeermen forbliver tom, nar du
har trykket pa en anden tast end Y, skal du forsgge at starte igen og
vaelge fejlsikret tilstand, nar du bliver spurgt.

5. Vealg det relevante sprog, og klik pa Fortsaet.

% Det anbefales, at du accepterer det tildelte standardtastatur for dit

sprog, medmindre du vil teste et bestemt tastatur.

6. Klik pa Jeg accepterer i slutbrugerens licensaftale, hvis du
accepterer betingelserne. Hjelpeprogrammet HP Insight
Diagnostics startes med fanen Survey vist.

www.hp.com Vejledning til fejlfinding
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Fanen Survey

Fanen Survey viser vigtige oplysninger om systemkonfigurationen.

I sektionen View i venstre side af skermbilledet kan du vaelge
visningen Summary for at fa vist begraensede konfigurationsdata
eller veelge visningen Advanced for at fa vist alle data i den valgte
kategori. Uanset om du velger Advanced eller Summary, er fglgende
kategorier af oplysninger tilgeengelige pa fanen Survey:

All — Viser en liste over alle kategorier af oplysninger om computeren.
Overview — Viser en liste over generelle oplysninger om computeren.
Architecture — Viser oplysninger om systemets BIOS og PCI-enhed.

Asset Control — Viser oplysninger om asset-tag, systemets
serienummer 0g processor.

Communication — Viser oplysninger om indstillingerne for computerens
parallelle (LPT) og serielle (COM) porte, USB-forbindelser og
netvarkscontrolleren.

Graphics — Viser oplysninger om computerens grafikcontroller.

Input Devices — Viser oplysninger om tastaturet, musen og andre
inputenheder, som er tilsluttet computeren.

Memory — Viser oplysninger om al hukommelse i computeren.
Herunder hgrer hukommelsesslots pa systemkortet og alle
installerede hukommelsesmoduler.

Miscellaneous — Viser oplysninger, der er hentet fra
computerkonfigurationshukommelsen (CMOS), BIOS-data
for systemstyringen, systemkortdata og oplysninger om
diagnosticeringskomponenter.

Storage — Viser oplysninger om de lagringsmedier, der er tilsluttet
computeren. Denne liste omfatter alle faste diske, diskettedrev og
optiske drev.

System — Viser oplysninger om systemkortet, processoren, kabinettet
og BIOS foruden oplysninger om den interne hgjttaler og PCI-bus.

Vejledning til fejlfinding
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Fanen Test

Med fanen Test kan du vaelge de dele afsystemet, du vil teste. Du kan
ogsa valge testtype og testtilstand.

Du kan valge mellem to testtilstande:

B Interactive Mode — Giver optimal kontrol over testforlgbet.
Diagnosticeringsprogrammet beder dig om input i Igbet af en test,
som kraver din indgriben. Du kan ogsa finde ud af, om testen er
bestaet eller ej.

B Unattended Mode — Viser ingen prompts og krever ingen
indgriben. Hvis der findes fejl, vises de, nar testen er fuldendt.

Du kan vaelge mellem tre testtyper:

B Quick Test — Indeholder et forudbestemt script, hvor en prgve pa
hver hardwarekomponent undersgges. Der kraves ingen indgreb
fra brugeren i hverken Unattended Mode eller Interactive Mode.

B Complete Test — Indeholder et forudbestemt script, hvorder
udfgres en komplet test af alle hardwarekomponenter. Der findes
flere testtyper i Interactive Mode, men de kraver brugerens
indgriben.

B Custom Test — Giver den mest fleksible kontrol over testen af et
system. Tilstanden Custom Test ggr det muligt at veelge pracist
de enheder, tests og testparametre, du vil benytte.

Séadan startes en test:
1. Velg fanen Test.

2. Valg Type of Test til venstre pa fanen for at veelge den testtype,
du vil udfgre (Quick, Complete eller Custom).

3. Velg Test Mode til venstre pa fanen (Interactive eller Unattended).
4. Velg den enhed pa rullelisten, som du vil teste.

5. Valg, hvordan testen skal udfgres: Number of Loops eller Total
Test Time. Nar du velger at kgre testen over et bestemt antal
loops, skal du angive det antal loops, du vil udfgre. Hvis du vil
kgre diagnosticeringstesten inden for et bestemt tidsinterval, skal
du angive tidsrummet i minutter.

www.hp.com Vejledning til fejlfinding
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6. Klik pa Begin Testing for at starte testen. Med fanen Status kan

du overvage testens forlgb, og dataene vises automatisk under
testen. Nar testen er fuldfert, viser fanen Status, om enheden
er bestaet.

7. Hvis der bliver fundet fejl, skal du gé til fanen Log og klikke pa

Fanen Status

fanen Error for at {4 vist supplerende oplysninger og anbefalede
handlinger.

Fanen Status viser statusen for de valgte test. Den udfgrte testtype
(Quick, Complete eller Custom) vises ogsa. Den overordnede
statuslinje viser fuldfgrelsen i procent for de igangverende tests.
Under testen vises knappen Cancel Testing, som du kan bruge til
at annullere testen.

Nar testen er fuldfgrt, erstattes knappen Cancel Testing af knappen
Retest. Knappen Retest tester det s@t a tests, som senest blev udfgrt.
Pé denne made kan du kgre et st af tests uden at skulle angive
dataene igen pa fanen Test.

Fanen Status viser ogsa:

De enheder, der bliver testet.

De tests, der kgrer i gjeblikket.

Den samlede forlgbne tid

Den forlgbne tid for de enkelte tests

Statusen for hver test

Vejledning til fejlfinding
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Fanen Log

Fanen Help

Fanen Log indeholder to logger, Test Loog og Error Log, som hver
kan veelges i venstre side pa fanen.

Test Log viser alle tests, der er blevet udfgrt, antal gange testen
er udfert, antal ikke-bestaede tests og den tid, det tog at udfgre den
enkelte test. Knappen Clear Test Log fjerner indholdet af Test Log.

Error Log viser tests for enheder, som ikke har bestaet

diagnosticeringstesten, og indeholder nedenstdende kolonner

af oplysninger.

B Isektionen Description beskrives den fejl, som diagnosticeringstesten
har fundet.

B Recommended Repair viser en anbefalet handling, som skal
udfgres for at afthjelpe problemer i den hardware, der ikke har
bestéet testen.

B Failed Count viser det antal gange, hvor testen ikke blev bestéet.

B Error Code viser en numerisk kode for fejlen. Fejlkoderne er
defineret pa fanen Help.

B Knappen Clear Error Log fjerner indholdet af fejlloggen.

Pa fanen Help kan du velge Error Codes eller Test Components
i venstre side pa fanen.

Visningen Error Codes indeholder en beskrivelse af hver numerisk
fejlkode og anbefalede handlinger for hver kode. Hvis du hurtigt vil
finde en beskrivelse af en fejlkode, skal du indtaste fejlkoden i feltet
gverst i vinduet og klikke pa knappen Find Error Codes.

Visningen Test Components viser grundleggende oplysninger om
de tests, der er kgrt.
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Lagring og udskrivning af oplysninger
i HP Insight Diagnostics
Du kan gemme de oplysninger, der er vist pa fanerne Status og Log
i HP Insight Diagnostics, pa en diskette eller en USB 2.0 HP-drevkode

(64 MB eller hgjere). Du kan ikke gemme dataene pa harddisken.
Systemet opretter automatisk en HTML-fil, der afspejler skermbilledet

1. Indsat en diskette eller en USB 2.0 HP-drevkode (kapacitet skal
vare 64 MB eller hgjere). USB 1.0-drevkode understgttes ikke.

2. Klik pa Save i gverste hgjre hjgrne pa fanen.
3. Velg Save to the floppy eller Save to USB key.

4. Indtast et filnavn i feltet File Name, og klik pa knappen Save.
Der gemmes en HTML-fil pa den indsatte diskette eller USB
HP-drevkode.

5. Udskriv oplysningerne fra den lagringsenhed, hvor du har gemt dem.

% Hvis du vil afslutte HP Insight Diagnostics, skal du klikke
pa Exit i gverste hgjre hjgrne i skeermbilledet og derefter fjerne
cd’en Dokumentation og diagnose fra det optiske drev.

Hentning af den seneste version af HP Insight Diagnostics

1. Ga til www.hp.com.
2. Klik pa fanen Support & Drivers (Support og drivere).

3. Klik pa alternativknappen Download driver and software
(Hent driver og software).

4. Indtast produktnummeret (f.eks. dc7600) i naeste felt, og tryk
pa tasten Enter.

5. Velg dit operativsystem.
6. Klik pa hyperlinket Diagnostic (Diagnosticering).
7. Find HP Insight Diagnostics, og klik p4 Download (Overfgr).

% Overfgrslen omfatter vejledning i, hvordan du opretter start-cd’en.

Vejledning til fejlfinding www.hp.com 1-7
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Beskyttelse af softwaren

Tag sikkerhedskopier af al software, alle programmer og relaterede
filer, der er lagret pa harddisken for at undga tab af data eller
beskadigelse af softwaren. I dokumentationen til operativsystemet
eller programmerne til sikkerhedskopiering kan du finde anvisninger
pa, hvordan du sikkerhedskopierer datafilerne.

Gendannelse af softwaren

Med Restore Plus! kan du gendanne operativsystemet Windows
og programmerne, som de var, da du kgbte computeren cd’en.
Se dokumentationen, der fglger med Restore Plus! pa cd’en for
at fa komplette anvisninger om at bruge funktionen.

1-8 www.hp.com Vejledning til fejlfinding
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Fejlfinding uden diagnose

Dette kapitel indeholder oplysninger om, hvordan du finder og

retter mindre problemer, f.eks. problemer med diskettedrev, harddisk,
optisk drev, grafik, lyd, hukommelse og software. Se skemaerne

i dette kapitel for at finde arsagen og de anbefalede Igsninger, hvis
der opstar problemer med computeren.

% Oplysninger om specielle fejlmeddelelser, der vises pa skeermen
under POST (Power-On Self-Test) ved start af computeren, finder
du i Appendiks A, “POST-fejlmeddelelser.”

Sikkerhed og komfort

ADVARSEL: Hvis computeren anvendes forkert eller der ikke etableres en
sikker og behagelig arbejdsplads, kan det give anledning til ubehag og
alvorlige personskader. Se Vejledning til sikkerhed og komfort p& cd’en
Dokumentation og diagnose eller p& webstedet www.hp.com/ergo for at
f& yderligere oplysninger om at vaelge arbejdsomréde og skabe et sikkert
og behageligt arbejdsmilje.

Dette udstyr er blevet testet og overholder graenserne for en digital enhed
i Klasse B, ifelge Del 15 i FCC-regulativerne. Yderligere oplysninger finder
du i Oplysninger om sikkerhed og regulativer p& cd’en Dokumentation og
diagnose.
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For du ringer til teknisk support

Hyvis du har problemer med computeren, kan du prgve de relevante
lgsninger herunder for at finde det ngjagtige problem, f@gr du ringer
til teknisk support.

Kgr diagnosticeringsprogrammet. Se Kapitel 1, “Computerens
diagnosticeringsfunktioner” for at fa flere oplysninger.

Kgr DPS (Drive Protection System) Self-Test i computerens
opsa&tningsprogram. Se Vejledning til computeropscetning (F10)
pa Dokumentation og diagnose-cd’en for at fa yderligere
oplysninger.

Kontroller lysdioden for strgmforsyning pa computerens forside
for at se, om den blinker rgdt. De blinkende lysdioder er fejlkoder,
som ggr det lettere at diagnosticere problemet. Se Appendiks A,
“POST-fejlmeddelelser” for at fa flere oplysninger.

Hvis skarmen er tom, og der findes et andet skaermstik, skal du
tilslutte skaermen til det. Du kan ogsa udskifte skaermen med en
skeerm, som du ved fungerer korrekt.

Hyvis du arbejder i et netveerk, skal du prgve at tilslutte en anden
computer med et andet computerkabel til netverksstikket.
Der kan vare problemer med netvarksstikket eller kablet.

Hyvis du har tilfgjet ny hardware for nylig, skal du fjerne hardwaren
igen, og kontrollere om computeren nu fungerer korrekt.

Hyvis du har tilfgjet ny software for nylig, skal du fjerne
installationen af softwaren, og kontrollere, om computeren
fungerer korrekt.

Start computeren i fejlsikret tilstand for at se, om den starter,
uden at alle driverne er indlast. Nar du starter operativsystemet,
skal du vaelge den senest kendte konfiguration.

Se den omfattende tekniske support online pd www.hp.com/support.
Se afsnittet “Nyttige tip” i denne brugerhandbog.

Kgr cd’en Restore Plus! cd’en.

f E FORSIGTIG: N&r du kerer cd’en Restore Plus! slettes alle data p& harddisken.

2-2
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HP Instant Support Professional Edition indeholder en
selvdiagnosticering, som hjzlper dig med at lgse problemer online.
Anvend onlinechatfunktionen i HP Instant Support Professional
Edition, hvis du har brug for at kontakte HP Support. Du har adgang
til HP Instant Support Professional Edition pa adressen:
www.hp.com/go/ispe.

Du har adgang til vores supportcenter for virksomheder (BSC) pa
adressen www.hp.com/go/bizsupport, og her kan du fa de seneste
oplysninger om onlinesupport, software og drivere, proaktiv besked
og kommunikere med ligestillede samt HP-eksperter i hele verden.

Hyvis det bliver ngdvendigt at ringe efter teknisk hjelp, skal du vaere
klar til at udfgre fglgende handlinger for at sikre, at dit opkald
handteres rigtigt:

B Szt dig foran computeren, nar du ringer.

B Noter computerens serienummer, produkt-id-nummer samt
skermens serienummer, fgr du ringer.

B Brug tid pé at finde arsagen til problemet sammen med
serviceteknikeren.

B Afbryd den hardware, der senest er blevet tilsluttet systemet.

B Fjern installationen af de programmer, der for nylig er blevet
installeret.

B Kogr Restore Plus! cd’en.

f E FORSIGTIG: Nar du kerer cd’en Restore Plus! slettes alle data p& harddisken.

% Oplysninger om salg og garantiopgraderinger (Care Packs) far du ved
at ringe til den lokale autoriserede serviceudbyder eller forhandler.
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Nyttige tip

Hvis der opstér problemer med computeren, skarmen eller softwaren,
kan du se fglgende liste med generelle Igsningsforslag, inden du
foretager dig yderligere:

Kontroller, at pc’en og skermen er tilsluttet en stikkontakt,
der virker.

Kontroller, at spendingsvalgeren (pa visse modeller) er angivet
til den rette spanding for dit omrade (115 V eller 230 V).

Kontroller, at pc’en er teendt, og at den grgnne lysdiode for strgm
lyser.

Kontroller, at skaermen er tendt, og at den grgnne lysdiode for
skermen lyser.

Kontroller lysdioden for strgmforsyning pa computerens forside

for at se, om den blinker rgdt. De blinkende lysdioder er fejlkoder,
som ggr det lettere at diagnosticere problemet. Se Appendiks A,

“POST-fejlmeddelelser” for at fa flere oplysninger.

Skru op for lysstyrken og kontrasten pa skeermen, hvis skeermen
er for mgrk.

Tryk pa en vilkarlig tast, og hold den nede. Hvis systemet bipper,
fungerer tastaturet korrekt.

Se alle kabelforbindelser efter for lgse eller ukorrekte forbindelser.

Vak computeren ved at trykke pa en vilkarlig tast pa tastaturet
eller ved at trykke pa afbryderen. Hvis systemet forbliver i standby,
skal du slukke computeren ved at trykke pa og holde afbryderen
nede i mindst fire sekunder. Tryk derefter pa afbryderen igen for
at genstarte computeren. Hvis systemet ikke slukkes, skal du tage
stikket ud af kontakten, vente i nogle fa sekunder og tilslutte det
igen. Computeren genstartes, hvis den er indstillet til automatisk
start efter strgmafbrydelse i computerens ops@tningsprogram.
Hvis computeren ikke genstartes, skal du trykke pa afbryderen
for at starte den.
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B Omkonfigurer computeren efter installation af et udvidelseskort
eller andet tilbehgr, der ikke er plug and play-enheder.
Se “Afhjaelpning af problemer med installation af hardware”
for at fa vejledning.

B Sgrg for, at alle ngdvendige enhedsdrivere er installeret.
Hvis du f.eks. bruger en printer, skal du ogsé bruge en driver
til den pagaldende printermodel.

B Tag alle startmedier ud (diskette, cd eller USB-enhed) af systemet,
for du teender det igen.

B Huvis du har installeret et andet operativsystem end det, der var
installeret fra fabrikken, skal du kontrollere at det understgttes
pa dette system.

B Hoyvis der er installeret flere skermkilder (integreret, PCI- eller
PCI-Express-adaptere) pa computeren (kun integreret skeerm pa
visse modeller) og kun en enkelt skeerm, skal du tilslutteske@rmen
i skeermstikket pa den kilde, der er valgt som den primare VGA-
adapter. Under start deaktiveres de andre skermstik, sa hvis du
tilslutter skeermen til en af disse porte, fungerer den ikke. Du kan
valge den kilde, der skal veere VGA-standardkilden, i computerens
ops&tningsprogram.

f E FORSIGTIG: Nér pc'en er tilsluttet en stikkontakt, er der altid strom pé
systemkortet. Netledningen skal tages ud af stikkontakten, inden pc’en
&bnes, for at forhindre beskadigelse af komponenterne eller systemkortet.
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Afhjzlpning af generelle problemer

Du kan méaske nemt selv Igse de generelle problemer, der er beskrevet
i dette afsnit. Hvis problemet fortsatter, og du ikke selv kan Igse det,
eller hvis du ikke fgler dig sikker pa en handling, skal du kontakte en

autoriseret forhandler.

Afhjzelpning af generelle problemer

Problem

Arsag

Losning

Pc’en synes l&st
og slukker ikke,
ndr der trykkes p&
afbryderknappen.

Softwarestyringen af

afbryderknappen fungerer

ikke.

1. Tryk p& afbryderknappen,
og hold den nede i mindst fire
sekunder, indtil computeren slukker.

2. Treek netledningen ud af
stikkontakten.

Computeren reagerer
ikke p& USB-tastaturet
eller musen.

Computeren er i standby.

Tryk p& afbryderen for at genoptage
aktivitet fra standby.

Systemet er |&st.

Genstart computeren.

FORSIGTIG: Tryk ikke p& afbryderknappen i leengere tid end fire sekunder, nér du
forsager at genoptage fra standby. | modsat fald slukkes computeren, og du mister
alle data, som ikke er gemt.

Computerens dato og
klokkeslzet er forkert.

Batteriet til realtidsuret
skal muligvis skiftes.

@y, Tilslutning af

computeren til en
aktiv stremkontakt
forlaenger levetiden
for batteriet til
realtidsuret.

Nulstil ferst dato og klokkeslaet

i Kontrolpanel (Computeropsaetning
kan ogsé& bruges til at opdatere
realtidsdato og -klokkeslzet).

Hvis problemet fortsaetter, skal

du udskifte batteriet til realtidsuret.
Se Hardwarevejledningen p&
Dokumentation og diagnose-cd’en for
at f& vejledning i issetning af et nyt
batteri, eller kontakt en autoriseret
forhandler for at f& udskiftet batteriet
til realtidsuret.

Markeren kan ikke
flyttes ved hjzelp of

piletasterne pd tastaturet.

Tasten Num Lock
er muligvis aktiveret.

Tryk p& tasten Num Lock. lysdioden
for Num Lock mé& ikke lyse, hvis du vil
bruge piletasterne. Du kan deaktivere
(eller aktivere) tasten Num Lock

i computerens opsaetningsprogram.
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Fejlfinding uden diagnose

Afhjzelpning af generelle problemer (Fortsat)

Problem

Arsag

Losning

Computerens deekplade
eller adgangspanel kan
ikke fjernes.

Smart Cover-l@sen,
som findes pd nogle
computere, er |3st.

L&s Smart Cover-l&sen op

ved hjelp af computerens
opsaetningsprogram (F10).

Hos HP kan du kebe en Smart Cover
FailSafe-negle, der kan deaktivere
Smart Cover-l&sen manuelt. Du skal
have en FailSafe-negle i tilfeelde of,
at adgangskoden bliver vaek, f.eks.
ved stramsvigt eller funktionsfejl. Bestil
varenummer 166527-001 for naglen
eller varenummer 166527-002 for
skruetraekkeren.

Ydelsen er nedsat.

Processoren er varm.

1. Kontroller, at luftstrammen til
computeren ikke er blokeret.

2. Kontroller, at ventilatorerne
er tilsluttet og fungerer korrekt
(visse ventilatorer fungerer kun,
n&r der er behov for det).

3. Kontroller, at processorens
kelekappe er korrekt monteret.

Harddisken er fuld.

Overfer data fra harddisken for at
frigere mere plads p& harddisken.

lkke meget ledig
hukommelse.

Tiltej mere hukommelse.

Harddisk fragmenteret.

Defragmenter harddisken.

Det program, som tidligere
havde adgang, frigjorde
ikke reserveret hukommelse
til systemet igen.

Genstart computeren.

Virus resident
p& harddisken.

Ker et virusbeskyttelsesprogram.

For mange programmer
er &bne.

1. Luk alle unedvendige programmer
for at frigere hukommelse.

2. Tilfej mere hukommelse.

Vejledning til fejlfinding
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Fejlfinding uden diagnose

Afhjzelpning af generelle problemer (Fortsat)

Problem Arsag Lesning

Ydelsen er nedsat. Nogle programmer, iszer 1. Reducer skeermoplasningen for

(fortsat) spil, belaster det grafiske det aktuelle program, eller se
undersystem. i den dokumentation, der fulgte

med programmet, for at &
forslag til, hvordan du eger
ydeevnen ved at justere

parametrene i programmet.

2. Tilfej mere hukommelse.

3. Opgrader grafiklesningen.

Arsag ukendt. Genstart computeren.
Computeren slukkede Processorens termiske 1. Serg for, at computerens
automatisk, og den beskyttelse er aktiveret: ventilationshuller ikke er blokeret,
rede lysdiode for stram  Ep ventilator er muligvis og at processorens kaleventilator
blinker fo gange hvert  plokeret eller drejer ikke kerer.
sekund, oefterfulgf afen  ryndt. 2. Abn l&get, tryk p& afbryderen,
pause pd to sekunder, ELLER og kontroller, at processorens

og computeren bipper

. ventilator drejer rundt. Hvis
to gange. (Bip-lydene

Kelekappen er ikke : :
PP I processorens ventilator ikke

stopper efter femte monteret korrekt p& drejer rundt, skal du kontrollere,
gent.qgelse, men processoren. at ventilatorkablet er tilsluttet
lysdioderne bl'lver systemkortets header. Kontroller,
ved med at blinke). at ventilatoren er placeret eller

installeret korrekt.

3. Hvis processorens ventilator
er tilsluttet og placeret korrekt,
men ikke drejer rundt, skal du

udskifte den.

4. Seet processorens koleklap pé
igen, og kontroller, at ventilatoren
er monteret korrekt.

5. Kontakt en autoriseret forhandler
eller serviceyder.
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Fejlfinding uden diagnose

Afhjzelpning af generelle problemer (Fortsat)

Problem Arsag Lesning

Systemet taendes ikke, Systemet kunne ikke Tryk p& og hold afbryderen nede
og lysdioderne pé teendes. i mindre end fire sekunder. Hvis
computerens forside harddiskens lysdioder lyser grent,
blinker ikke. skal du gere felgende:

1. Kontroller, at spaendingsvaelgeren
bag pé stremforsyningen
(p& visse modeller) er angivet til
den rette spaending. Den rette
indstilling af spaendingen
atheenger af det aktuelle omrade.

2. Fjern udvidelseskortene et ad
gangen, indtil lysdioden 5 V_aux
p& systemkortet lyser.

3. Udskift systemkortet.
ELLER

Tryk p& og hold afbryderen nede

i mindre end fire sekunder. Hvis
harddiskens lysdiode ikke lyser grent,
skal du derefter gore folgende:

1. Kontroller, at enheden er tilsluttet
et fungerende stromstik.

2. Abn ladget, og kontroller, at
afbryderen er tilsluttet korrekt
til systemkortet.

3. Kontroller, at begge
stremforsyningskabler er tilsluttet
korrekt il systemkortet.

4. Kontroller, at lysdioden 5 V_aux
p& systemkortet lyser. Hvis den
lyser, kan du tilslutte afbryderen
igen.

5. Hvis lysdioden 5 V_aux pé
systemkortet ikke lyser, skal du
bruge en anden stremforsyning.

6. Udskift systemkortet.
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Fejlfinding uden diagnose

Afhjzelpning af problemer med stremforsyningen

Tabellen i det fglgende indeholder almindelige arsager og Igsninger
pa problemer med strgmforsyningen.

Afhjelpning af problemer med stremforsyningen

Problem

Arsag

Losning

Stremforsyningen lukker
af og til ned.

Speendingsvaelgeren
bag p& computerens
kabinet (pd visse
modeller) stér ikke p&
den korrekte spaending

(115 V eller 230 V).

Veelg den korrekte spaending med
vaelgerkontakten.

Stremforsyningen
teender ikke, pga.

en fejl p& den interne
stremforsyning.

Kontakt en autoriseret tienesteudbyder
for at udskifte stremforsyningen.

Computeren slukkede
automatisk, og den rede
lysdiode for strem blinker
to gange hvert sekund,
efterfulgt af en pause pd to
sekunder, og computeren
bipper to gange. (Bip-lydene
stopper efter femte
gentagelse, men lysdioderne
bliver ved med at blinke).

Processorens termiske
beskyttelse er aktiveret:
En ventilator er muligvis
blokeret eller drejer ikke
rundt.

ELLER
Kelekappen er ikke

monteret korrekt p&
processoren.

1. Serg for, at computerens
ventilationshuller ikke er
blokeret, og at processorens
keleventilator kerer.

2. Abn l&get, tryk p& afbryderen,
og kontroller, at processorens
ventilator drejer rundt. Hvis
processorens ventilator ikke
drejer rundt, skal du kontrollere,
at ventilatorkablet er tilsluttet
systemkortets header. Kontroller,
at ventilatoren er placeret eller
installeret korrekt.

3. Hvis processorens ventilator
er tilsluttet og placeret korrekt,
men ikke drejer rundt, skal du
udskifte den.

4. St processorens keleklap pé
igen, og kontroller, at ventilatoren
er monteret korrekt.

5. Kontakt en autoriseret forhandler
eller serviceyder.

www.hp.com
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Fejlfinding uden diagnose

Afhjelpning af problemer med stremforsyningen (Forisat)

Problem Arsag Lesning

Den rade lysdiode for Stremsvigt 1. Kontroller, at spaendingsvaelgeren
stram blinker fire gange (stramforsyningen bag pé& stremforsyningen

pr. sekund, efterfulgt af er overbelastet). (p& visse modeller) er angivet
en pause pd to sekunder, til den retfte spaending. Den rette
og computeren bipper fire indstilling af spaendingen
gange. (Bip-lydene stopper afhaenger af det aktuelle

efter femte gentagelse, men omrdde.

lysdioderne bliver ved med 2. Abn laget, og kontroller,

at blinke).

at stremforsyningskablet med
4 eller 6 ledere er tilsluttet stikket
p& systemkortet.

3. Kontroller, om en enhed
forérsager problemerne, ved
at fierne ALLE tilsluttede enheder
(f.eks. harddisk, diskettedrev eller
optiske drev og udvidelseskort).
Teend systemet. Hvis systemet
skifter til POST, skal du slukke og
udskifte en enhed ad gangen og
gentage proceduren, indtil fejlen
forekommer. Udskift den enhed,
der fordrsager fejlen. Fortszet
med at tilfeje enhederne én ad
gangen for at sikre, at alle
enheder fungerer korrekt.

4. Kontakt en autoriseret
tienesteudbyder for at
udskifte stremforsyningen.

5. Udskift systemkortet.
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Fejlfinding uden diagnose

Afhjelpning

af disketteproblemer

Tabellen i det fglgende indeholder almindelige arsager og Igsninger
pa problemer med disketter.

Det kan vere ngdvendigt at rekonfigurere pc’en, nér du tilfgjer eller
fjerner hardware, som f.eks. et ekstra diskettedrev. Se “Afhjalpning af
problemer med installation af hardware” for at fa vejledning.

Afhjzelpning af disketteproblemer

Problem

Arsag

Losning

lysdioden for diskettedrev

forbliver teendt.

Disketten er beskadiget.

| Microsoft Windows XP skal du
hajreklikke p& Start, klikke p&
Stifinder, og veelge et drev.
Veelg Filer > Egenskaber >
Funktioner. Under Status for
fejlsegning skal du klikke p&
Undersog nu.

Disketten er ikke korrekt
isat.

Tag disketten ud, og seet den i igen.

Drevkablet er ikke
tilsluttet korrekt.

Seet drevkablet i igen. Kontroller,
at alle fire ben pé& diskettedrevets
stramkabel er sluttet til drevet.

Drevet kan ikke findes.

Kablet sidder lost.

Seet diskettedrevets strem- og
datakabel i igen.

Det flytbare drev er ikke
korrekt placeret.

Seet drevet i igen.

Diskettedrevet kan ikke
skrive til disketten.

Disketten er ikke
formateret.

Formatér disketten.

1. Veelg drev (A) i Windows
Stifinder.

2. Hojreklik p& drevbogstavet,
og veelg Formater.

3. Velg de onskede indstillinger,
og klik p& Start for at begynde
formateringen af disketten.

Disketten er
skrivebeskyttet.

Brug en anden diskette, eller fiern
skrivebeskyttelsen.

www.hp.com
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Fejlfinding uden diagnose

Afhjelpning af disketteproblemer (Forfsat)

Problem

Arsag

Losning

Diskettedrevet kan ikke
skrive til disketten
(fortsat)

Der skrives fil det
forkerte drev.

Kontrollér drevbogstavet i drevstien.

Der er ikke tilstraekkelig
plads pé& disketten.

1. Brug en anden diskette.

2. Slet unedvendige filer fra
disketten.

Skrivning fra
legacydiskette er
deaktiveret i computerens
opsaetningsprogram.

Ker computerens
opseetningsprogram, og aktiver
Legacy Diskette Write under
Storage > Storage Options.

Disketten er beskadiget.

Udskift den beskadigede disk.

Disketten kan ikke
formateres.

Der er angivet et
ugyldigt medie.

Angiv diskettens kapacitet, nér du
formaterer en diskette i MS-DOS.
Hvis du f.eks. skal formatere en
1,44 MB-diskette, skal du skrive
felgende kommando ved

MS-DOS-prompten:
FORMAT A: /F:1440

Disketten er méske
skrivebeskyttet.

Abn diskettens laseanordning.

Disketten er
skrivebeskyttet.

Ker computerens opsaetningsprogram,
og aktiver Legacy Diskette Write
under Storage > Storage
Options.

Der er opst8et et problem
med en diskoverforsel.

Biblioteksstrukturen
er forkert, eller der er
opstéet en fejl i en fil.

| Windows XP skal du hgjreklikke
p& Start, klikke p& Stifinder,
og velge et drev. Veelg Filer >
Egenskaber > Funktioner.
Klik p& Underseg nu under
Status for fejlsegning.

Vejledning til fejlfinding
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Fejlfinding uden diagnose

Afhjelpning af disketteproblemer (Forfsat)

Problem

Arsag

Losning

Diskettedrevet kan ikke
laese en diskette.

Du bruger den forkerte
diskettetype til drevet.

Kontrollér, at du bruger den
rigtige diskettetype.

Der lzeses fra det
forkerte drev.

Kontrollér drevbogstavet i drevstien.

Disketten er beskadiget.

Skift disketten ud med en anden.

Meddelelsen “Ugyldig
systemdisk” vises.

Der sidder en diskette,
som ikke indeholder
systemfiler, der kan
starte computeren,

i drevet.

Tag disketten ud, ndr
drevaktiviteten stopper, og tryk
pé mellemrumstasten.
Computeren skulle starte nu.

Der opstod en diskettefej.

Genstart computeren ved at trykke
p& afbryderen.

Der kan ikke bootes
fra disketten.

Disketten er ikke
en bootdiskette.

Isset en diskette, der kan bootes fra.

Boot fra diskette

er deaktiveret

i computerens
opsaetningsprogram.

1. Ker computerens
opsaetningsprogram, og aktiver
boot fra diskette | Storage >
Boot Order.

2. Ker computerens
opsaetningsprogram, og
aktiver boot fra diskette
under Storage > Storage
Options > Removable
Media Boot.

@y, Begge tfrin ber bruges
som funktionen til boot fra et
udtageligt medie, Removable
Media Boot i computerens
opsaetningsprogram og overskriver
aktiveringskommandoen for
startreekkefolgen, Boot Order.

www.hp.com
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Fejlfinding uden diagnose

Afhjelpning af disketteproblemer (Forfsat)

Problem Arsag

Der kan ikke bootes
fra disketten.

Losning

Netvaerksservertilstanden  Kar computerens opsaetningsprogram,
er aktiveret i computerens  og deaktiver Network Server

(fortsat)

opsaetningsprogram.

Mode i Security > Password
Options.

Boot fra flytbart
medie er deaktiveret
i computerens
opsaetningsprogram.

Ker computerens opszetningsprogram,
og aktiver boot fra flytbart medie

i Storage > Storage Options >
Removable Media Boot.

Harddiskproblemer

Afhjelpning af harddiskproblemer

Problem

Arsag

Losning

Fejl p& harddisken.

Harddisken har
beskadigede sektorer
eller er g&et ned.

1. I Windows XP skal du hejreklikke
p& Start, klikke p& Stifinder,
og veelge et drev. Veelg Filer >
Egenskaber > Funktioner.
Under Status for fejlsegning
skal du klikke p& Underseg nu.

2. Brug et hjeelpeprogram til at
finde og forhindre brugen af de
darlige sektorer. Genformatér
harddisken, hvis det er
nedvendigt.

Problem med
diskoverfarslen.

Enten er der fejl i
biblioteksstrukturen,
eller der er opstéet
en fejl i en fil.

| Windows XP skal du hgjreklikke
p& Start, klikke p& Stifinder,
og velge et drev. Velg Filer >
Egenskaber > Funktioner.
Under Status for fejlsegning
skal du klikke p& Underseg nu.

Vejledning til fejlfinding
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Fejlfinding uden diagnose

Afhjelpning af harddiskproblemer (Fortsat)

Problem

Arsag

Losning

Drevet kan ikke findes
(identificeres).

Kablet er muligvis lest.

Kontrollér kabelforbindelserne.

Systemet har muligvis
ikke genkendt en
nyinstalleret enhed
automatisk.

Se anvisningerne for ny konfiguration
i afsnittet “Afhjzelpning af problemer
med installation af hardware”.
Kontroller, om enheden findes

pé listen i computerens
opseetningsprogram, hvis systemet
stadig ikke genkender den nye
enhed. Hvis enheden findes p&
listen, er der sandsynligvis tale om et
driverproblem. Hvis den ikke findes
pd listen, er rsagen sandsynligvis
et hardwareproblem.

Abn computerens opsaetningsprogram,
og forseg at tilfeje en pause

i POSTHorsinkelse under
Advanced > Power-On.

Drevets controller

er deaktiveret

i computerens
opszetningsprogram.

Ker computerens opsaetningsprogram,
og aktiver alle SATA-controllere i
Storage > Storage Options.

Drevet reagerer

langsomt lige efter start.

Ker computerens opsaetningsprogram,
og eg indstillingen af POST{orsinkelsen
under Advanced > Power-On
Options.

www.hp.com
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Fejlfinding uden diagnose

Afhjelpning af harddiskproblemer (Fortsat)

Problem

Arsag

Losning

Meddelelse om
ikke-systemdisk/
NTLDR mangler.

Systemet forseger at
starte fra en diskette,

der ikke kan startes fra.

Tag disketten ud af diskettedrevet.

Systemet forseger at
starte fra harddisken,
men den er muligvis
beskadiget.

. Saet en diskette, der kan startes

fra, i diskettedrevet, og genstart
computeren.

. Kontroller harddiskens format

med fdisk:

Ved NTFS-formatering kan

du bruge en tredjeparts laeser
til at vurdere drevet.

Ved FAT32-formatering er der
ikke adgang til harddisken.

. Installer systemfilerne til det

p&geeldende operativsystem.

Systemfilerne mangler
eller er ikke installeret
korrekt.

. Saet en diskette, der kan startes

fra, i diskettedrevet, og genstart
computeren.

. Kontroller harddiskens format

med Fdisk:

Ved NFTFS-formatering kan
du bruge en tredjeparts laeser
til at vurdere drevet.

Ved FAT32-formatering er der
ikke adgang til harddisken.

Start fra harddisk

er deaktiveret

i computerens
opsaetningsprogram.

Ker computerens opsaetningsprogram,
og aktiver harddisken pé listen
Storage > Boot Order.

Vejledning til fejlfinding
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Fejlfinding uden diagnose

Afhjelpning af harddiskproblemer (Fortsat)

Problem

Arsag

Losning

Meddelelse om
ikke-systemdisk/
NTLDR mangler.
(fortsat)

En harddisk, der kan
startes fra, er ikke
installeret forst i en
konfiguration med

flere harddiske.

Hvis du forseger at starte fra en
harddisk, skal du kontrollere, at den
er tilsluttet systemkortstikket med

maerkatet P60 SATA O.

Controlleren til en
harddisk, der kan

startes fra, star ikke

overst i startraekkefelgen.

Abn computerens opsaetningsprogram,
og vlg Storage > Boot Order,
og kontroller at controlleren til den
harddisk, der skal startes fra, er anfert
lige under linjen Hard Drive.

Computeren starter ikke.

Harddisken er
beskadiget.

Se om lysdioden pé frontpanelet
blinker redt, og om der heres
biplyde. Se Appendiks A,
“POST-ejlmeddelelser” for at finde
de mulige rsager til, at lampen
blinker redt, og lees bipkoderne.

Se vilkér og betingelser i den
verdensomspaendende begraensede
garanti.

Computeren synes |&st.

Programmet, der er
i brug, er holdt op

med at reagere pé
kommandoerne.

Forsag den normale fremgangsméde
for nedlukning i Windows. Tryk pé
afbryderen i mindst fire sekunder
for at slukke for strammen, hvis en
normal nedlukning ikke lykkes. Tryk
p& afbryderen igen for at genstarte
computeren.
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Vejledning til fejlfinding



Fejlfinding uden diagnose

Afhjzelpning af MultiBay-problemer

Afhjelpning af MultiBay-problemer

Problem

Arsag

Losning

Drevet kan ikke findes.

Du har forsegt en hot
plugHilslutning af et
flytbart drev, hvor
Drivelock-sikkerheden
er aktiveret. (Funktionen
understettes kun pé
nogle modeller).

Luk Windows, og sluk computeren.
Seet drevet i MultiBay, hvis det ikke
allerede er installeret. Teend
computeren.

MultiBay er deaktiveret
i computerens
opsaetningsprogram.

Abn computerens opsaetningsprogram,
og indstil MultiBay til Device
Available i Security > Device
Security.

Afhjzelpning af problemer med sksermen

Hvis der opstar problemer med skarmen, skal du se i dokumentationen,
der fulgte med skeermen, og i tabellen med almindelige arsager og
lgsninger nedenfor.

Afhjelpning af problemer med skzermen

Problem

Arsag

Losning

Sort skaerm (ingen visning).

Skaermen er ikke teendt,
og lysdioden for skaermen
lyser ikke.

Teend skaermen, og kontroller at
lysdioden for skaerm lyser.

Forkert skaerm.

Prev en anden skeerm.

Kabeltilslutningerne
er ikke korrekte.

Kontroller kabelforbindelserne
mellem skaermen, computeren
og stikkontakten.

Der er méske installeret
en funktion til sort skaerm,
eller funktionerne til
energibesparelse er
aktiveret.

Tryk pé& en vilkérlig tast, eller klik
med museknappen, og skriv din
adgangskode, hvis den er defineret.

Vejledning til fejlfinding
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Fejlfinding uden diagnose

Afhjelpning af problemer med skaermen (Fortsat)

Problem Arsag

Losning

Sort skeerm (ingen visning).  Der er fejl i

(fortsat) systemhukommelsen,
og systemet kerer i
Boot Block Emergency
Recovery-tilstand
(angives med otte

biplyde).

Flash systemhukommelsen igen med
den seneste BIOS. Se afsnittet “Boot
Block Emergency Recovery Mode” i
Vejledning til desktopadministration
p& Dokumentation og diagnose-cd’en
for at f& flere oplysninger.

Du bruger en skaerm
med fast synkronisering,
og synkronisering er
ikke mulig ved den
valgte oplesning.

Serg for, at skeermen kan
acceptere samme vandrette
scanningshastighed som
oplesningen.

Computeren er
i standby.

Tryk pé& afbryderen for at genoptage
aktivitet fra standby.

FORSIGTIG: Tryk ikke p& afbryderknappen i leengere tid end fire sekunder, nér du
forseger at genoptage fra standby. | modsat fald slukkes computeren, og du mister

alle data, som ikke er gemt.

Sksermkablet sidder
i det forkerte stik.

Hvis systemet har b&de et integreret
grafikstik og et skaermstik fil
tilfojelseskort, skal skaermkablet
saettes i grafikkortets stik bag pé
computeren.

@y, Hvis grafikkortet er et standard
PCl-udvidelseskort, kan du aktivere
den integrerede grafik i computerens
opsaetningsprogram. Hvis et
grafikkort af typen PCl-Express
er installeret, kan den integrerede
grafik ikke aktiveres.
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Fejlfinding uden diagnose

Afhjelpning af problemer med skaermen (Fortsat)

Problem

Arsag

Losning

Sort skaerm (ingen visning).
(fortsat)

Skeermindstillingerne
i computeren er ikke
kompatible med
skaermen.

1

. Genstart computeren, og tryk

p& F8 under start, nér du ser
“Press F8” i nederste hojre
hjerne af skaermen.

. Veelg Enable VGA Mode

med piletasterne pé& tastaturet,
og tryk pé& Enter.

. Dobbeltklik pé ikonet Skaerm

i Windows Kontrolpanel, og
veelg fanen Indstillinger.

. Brug skyderen til at nulstille

oplesningen.

Skeaermen er tom, og den
rede lysdiode for strem
blinker fem gange pr.
sekund, efterfulgt af en
pause pd to sekunder,

og computeren bipper fem
gange. (Bip-lydene stopper
efter femte gentagelse, men
lysdioderne bliver ved med

at blinke).

Hukommelsesfeil
fer videomodul.

4.

. Seet DIMM-modulerne i igen.

Teend systemet.

. Udskift DIMM-modulerne et ad

gangen for at isolere det modul,
der ikke fungerer.

. Udskift tredjepartshukommelse

med HP-hukommelse.
Udskift systemkortet.

Skeermen er tom, og den
rede lysdiode for strem
blinker seks gange pr.
sekund, efterfulgt af en
pause pé to sekunder,

og computeren bipper seks
gange. (Bip-lydene stopper
effer femte gentagelse, men
lysdioderne bliver ved med

at blinke).

Grafikfejl for
videomodul.

For systemer med et grafikkort:

1.

2.
3.

Seet grafikkortet rigtigt i.
Teend systemet.

Udskift grafikkortet.
Udskift systemkortet.

Udskift systemkortet, hvis systemet
har et integreret grafikkort.

Vejledning til fejlfinding
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Afhjelpning af problemer med skaermen (Fortsat)

Problem Arsag Lesning

Skaermen er tom, og den Fejl p& systemkortet Udskift systemkortet.
rede lysdiode for strom (fejl sporet i ROM fer

blinker syv gange pr. skaermmodulet).

sekund, efterfulgt af en
pause pd to sekunder,
og computeren bipper syv
gange. (Bip-lydene stopper
efter femte gentagelse, men
lysdioderne bliver ved med

at blinke).
Skeaermen fungerer ikke Du bruger en skaerm, Deaktivér funktionerne
korrekt, n&r den bruges der ikke understetter til energibesparelse.
sammen med funktionerne  energibesparelse,
til energibesparelse. med funktionerne il
energibesparelse
aktiveret.
Tegnene er utydelige. Knapperne for lysstyrke  Reguler skaermens lysstyrke- og
og kontrast er ikke kontrastknapper.
indstillet korrekt.
Kablerne er ikke tilsluttet  Serg for, at grafikkablet sidder fast
korrekt. i grafikkortet og skaermen.
Skeermbilledet er utydeligt,  Hvis grafikcontrolleren Installér skaermdriverne, der fulgte
eller den valgte oplesning  er opgraderet, er de med opgraderingen.
kan ikke indstilles. korrekte grafikdrivere

muligvis ikke indlaest.

Skaermen kan ikke Skift oplesning.
vise den oplesning,
der anmodes om.

Forkert grafikkort. Udskift grafikkortet.
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Afhjelpning af problemer med skaermen (Fortsat)

Problem

Arsag

Losning

Billedet er brudt, det ruller,

ryster eller blinker.

Forbindelserne til
skaermen er ikke
korrekte, eller skaermen
kan vaere forkert
justeret.

1. Serg for, at skeermkablet er
sluttet korrekt til computeren.

2. | et toskaermssystem, eller hvis
en anden skaerm er anbragt teet
pd, skal du serge for, at skeermene
ikke forstyrrer hinandens
elekiromagnetiske felt ved at
flytte dem vaek fra hinanden.

3. lysstofrer eller ventilatorer er
méske for teet pd skaermen.

Skeermen skal
afmagnetiseres.

Afmagnetiser skaermen. Se i
dokumentationen, der fulgte med
skaermen, for yderligere anvisninger.

Billedet er ikke centreret.

Placeringen skal
muligvis justeres.

Tryk p& knappen Menu for at 8bne
OSD-menuen. Veelg Image
Control/Horizontal Position
eller Vertical Position for at
justere den vandrette eller lodrette
placering af billedet.

“No Connection, Check
Signal Cable” vises pé
skaermen.

Skeermkablet er ikke
tilsluttet.

Tilslut videokablet mellem skaermen
og computeren.

Kontroller, at stremmen er
sl&et fra computeren, mens
du tilslutter skaermkablet.

Der stér “Out of Range”
p& skaermen.

Skeermoplesningen og
opdateringshastigheden
er angivet til en hojere
vaerdi, end skaermen
understetter.

Genstart computeren i fejlsikret
tilstand. Tilpas indstillingerne til en
understettet indstilling, og genstart
derefter computeren, s& de nye
indstillinger kan treede i kraft.

Vibrationer eller raslelyde,

der kommer inde fra en
CRT-skeerm, nér den
taendes.

Skeaermens
afmagnetiseringsspole
er aktiveret.

Ingen. Det er normalt, at
afmagnetiseringsspolen aktiveres,
ndr skaermen taendes.

Vejledning til fejlfinding
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Afhjelpning af problemer med skaermen (Fortsat)

Problem Arsag Lesning
Klikkelyde, der kommer Elektroniske releeer er Ingen. Det er normalt, at visse
inde fra en CRT-skaerm. aktiveret inde i skeermen.  skaerme laver en klikkelyd, nér de

teendes og slukkes, nér standby
aktiveres eller deaktiveres, og nér
oplesningen zendres.

Der kommer hgje lyde inde  Indstillingerne for Veelg en lavere indstilling for

fra en fladskaerm. lysstyrke og/eller lysstyrke og/eller kontrast.
kontrast er for hoje.

Uskarpt fokus, striber, Fladskaermens 1. Veelg skeermindstillingen

spogelsestryk eller interne digitale for automatisk justering

skyggevirkninger, vandret  konversionskredse i skeermmenuen.

rullende !injer, svage kan muligvis. ikke 2. Synkroniser manuelt

|oc|reﬁe linjer, eller b°|||edef fortolke graﬁkkorfets. funktionerne til visning of

kan ikke centreres p& udgangssynkronisering uret og clockfrekvensen pé

skaermen. korrekt.

skaermen. Hvis du vil hente en
programpakke til at hjeelpe dig
med at synkronisere, skal du gé
til folgende websted, vaelge den
relevante skeerm og hente enten
SP20930 eller SP22333:
www.hp.com/support

Grafikkortet er ikke 1. Seet grafikkortet rigtigt i.

korrekt installeret, eller 5 Udekift arcfikkorter
det er et forkert kort. - Udskitt gratikkortet.

(geelder kun fladskeerme,
der bruger en analog
VGA-indgangstilslutning)

Visse trykte symboler vises  Den skrifttype, du Brug tegnoversigten til at finde og

ikke korrekt. bruger, understetter vaelge det relevante symbol. Klik p&
ikke det p8geeldende Start > Alle programmer >
symbol. Tilbehor > Systemveerktojer >

Tegnoversigt. Du kan kopiere
symbolet fra Tegnoversigten il et
dokument.
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Afhj=lpning af problemer med lyd

Hvis computeren har lydfunktioner, og der opstéar problemer med
lyden, skal du se de almindelige arsager og lgsninger, der er angivet
i tabellen nedenfor:

Afhjelpning af problemer med lyd

Problem Arsag Lesning
Lyden slés til og fra. Processorens ressourcer  Luk alle de programmer, der kraever
bruges af andre processorkraft.
programmer, der er
&bne.
Latenstid for direkte | Windows XP:

lyd er almindeligt
i mange medieafspiller-
programmer.

1. Velg Lyde og lydenheder
i Kontrolpanel.

2. Under fanen Lyd skal du veelge
en enhed p4 listen Afspilning
af lyd.

3. Klik p& knappen Avanceret,
og valg fanen Ydeevne.

4. Indstil skyderen
Hardwareacceleration
til Ingen og skyderen for
konverteringskvalitet af
samplefrekvens til God,
og afprev lyden igen.

5. Indstil skyderen
Hardwareacceleration
til Fuld og skyderen for
konverteringskvalitet af
samplefrekvens til Bedst,
og afprev lyden igen.
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Afhjelpning af problemer med lyd (Fortsat)

Problem

Arsag

Losning

Der kommer ikke lyd
ud af hejttaleren eller
hovedtelefonerne.

Der er skruet ned for
lyden ved hjeelp aof
softwaren.

Dobbeltklik p& ikonet Hojttaler p&
proceslinjen, og kontroller derefter,
at Sl& fra ikke er markeret. Brug
skyderen til at indstille lydstyrken.

lyden er deaktiveret
i computerens
opsaetningsprogram.

Aktiver lyden i computerens
opsaetningsprogram. Security >
Device Security > Audio.

De eksterne hgijttalere
er ikke teendt.

Teend de eksterne heijttalere.

De eksterne hgijttalere
er tilsluttet det forkerte

lydistik.

Se dokumentationen til lydkortet
vedrarende korrekt tilslutning.

Digital musik-cd er ikke
aktiveret.

Aktiver digital musik-cd:
1. Veelg System i Kontrolpanel.

2. Klik p& fanen Hardware,
og klik derefter p& knappen
Enhedshéandtering.

3. Hojreklik p& enheden CD/DVD,
og veelg Egenskaber.

4. Klik p& fanen Egenskaber,
og kontroller, at Aktiver
digital cd-lyd for denne
cd-rom-enhed er markeret.

Hovedtelefonerne eller
enhederne, der er
tilsluttet det udg&ende
stik, deemper den
inferne heijttaler.

Teend, og brug hovedtelefonerne
eller de eksterne hgittalere, hvis
de er tilsluttet, eller afbryd
hovedtelefonerne eller de eksterne
hejttalere.
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Fejlfinding uden diagnose

Afhjelpning af problemer med lyd (Fortsat)

Problem Arsag

Losning

Der kommer ikke lyd Lyden er sl&et fra.
ud af hejttaleren eller
hovedtelefonerne.

(fortsat)

1. Abn Kontrolpanel, klik p&
Lyd, Tale- og lydenheder,
og klik derefter p& Lyde og
lydenheder.

2. Klik p& afkrydsningsfeltet Slé
fra for at fierne markeringen heri.

Computeren er
i standby.

Tryk pé& afbryderen for at genoptage
aktivitet fra standby.

FORSIGTIG: Tryk ikke p& afbryderknappen i lzengere tid end fire sekunder, nér du
forsager at genoptage fra standby. | modsat fald slukkes computeren, og du mister

alle data, som ikke er gemt.

Hovedtelefonemetilsluttes
i lydudgangsstikket

bag p& enheden.
lydudgangsstikket bag
pd enheden er beregnet
til lydenheder, der tilsluttes
stremforsyningen, og er
ikke beregnet il brug af
hovedtelefoner.

lyden fra hovedtelefonerne
er utydelig eller deempet.

Tilslut hovedtelefonerne
i hovedtelefonstikket p&
computerens forside.

Harddisken er muligvis

fuld.

Computeren virker |&st
under musikoptagelsen.

Kontroller, at der er tilstraekkelig
meget ledig plads p& harddisken.
Du kan ogsé& preve at optage
musikfilen i et komprimeret format.

www. hp.com
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Afhjzelpning af problemer med printeren

Hvis der opstar problemer med printeren, skal du se i dokumentationen
til skeermen og i tabellen med almindelige arsager og Igsninger
nedenfor.

Afhjelpning af problemer med printeren

Problem

Arsag

Losning

Printeren vil ikke udskrive.

Printeren er ikke taendt
og online.

Teend printeren, og kontroller at den
er online.

De korrekte
printerdrivere il
programmet er ikke
installeret.

1. Installér den korrekte
printerdrivere til programmet.

2. Prov at udskrive ved hjeelp
af MS-DOS-kommandoen:
DIR C:\ > [printerport]
hvor [printerport] er adressen
pd den printer, der skal bruges.

Genindlzes printerdriveren, hvis
printeren fungerer.

Hvis du er pd et netvaerk,
er du maske ikke
tilsluttet printeren.

Serg for, at der er korrekt
netvaerkstilslutning til printeren.

Der kan veere en fejl
pa printeren.

Ker printerens selvtest.

Printeren vil ikke taende.

Kablerne er muligvis
ikke tilsluttet korrekt.

Tilslut alle kablerne igen, og kontroller
stramkablet og stikkontakten.

Printeren udskriver
forvanskede tegn.

De korrekte
printerdrivere il
programmet er
ikke installeret.

Installér den korrekte printerdrivere
til programmet.

Kablerne er muligvis
ikke tilsluttet korrekt.

Tilslut alle kabler igen.

Printeren har muligvis
ikke hukommelse nok.

Nulstil printeren ved at slukke den
i et minut, og teend den igen.

Printeren er offline.

Der kan mangle papir
i printeren.

Kontroller papirbakken, og fyld mere
papir i, hvis den er tom. Veelg online.
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Afhjzlpning af problemer med tastatur og mus

Hvis der opstér problemer med tastaturet eller musen, skal du se
i dokumentationen til udstyret og i tabellen med almindelige arsager

og lgsninger nedenfor.

Afhjelpning af tastaturproblemer

Problem Arsag

Losning

Computeren genkender Tastaturstikket er ikke
ikke tastaturets kommandoer  sat rigtigt i.

eller det, der skrives med

tastaturet.

1. Klik p& knappen Start pd
Windows-skrivebordet.

2. Klik p& Luk computeren.
Dialogboksen Luk Windows
vises.

3. Klik pé Luk computeren.

4. Slut tastaturet til bag p&
computeren, og genstart
computeren, ndr nedlukningen
er feerdig.

Programmet, der er
i brug, er holdt op

med at reagere pé
kommandoerne.

Luk computeren ned med musen,
og genstart computeren.

Tastaturet skal
repareres.

Se vilkér og betingelser i den
verdensomspaendende begraensede
garanti.

Fejl i trédles enhed.

1. Kontroller enhedens status
i softwaren, hvis det er muligt.

2. Kontroller/udskift enhedens
batterier.

3. Nulstil modtageren og tastaturet.

Computeren er
i standby.

Tryk pé& afbryderen for at genoptage
aktivitet fra standby.

FORSIGTIG: Tryk ikke p& afbryderknappen i leengere tid end fire sekunder, nér du
forseger at genoptage fra standby. | modsat fald slukkes computeren, og du mister

alle data, som ikke er gemt.
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Afhjlpning af tastaturproblemer (Fortsat)

Problem Arsag

Losning

Markeren kan ikke flyttes Tasten Num Lock
ved hjelp aof piletasterne er muligvis aktiveret.
pé tastaturet.

Tryk pé tasten Num Lock.
lysdioden for Num Lock mé& ikke
lyse, hvis du vil bruge piletasterne.
Tasten Num Lock kan deaktiveres.
(eller aktiveres) i computerens
opsaetningsprogram.

Afhjelpning af museproblemer

Problem Arsag Losning

Musen reagerer ikke, Musens stik er ikke Luk computeren ned ved hjzelp
ndr den flyttes, eller sat korrekt i bag pé& af tastaturet.

den er for langsom. computeren. 1. Tryk pé tasterne Ctrl og

Esc samtidigt (eller tryk p&
Windows-logotasten)
for at t& vist menuen Start.

2. Brug Pil op eller Pil ned til at
vaelge Luk computeren,
og tryk derefter p& Enter.

3. Brug Pil op eller Pil ned til at
veelge Luk computeren,
og tryk derefter p& Enter.

4. Slut musen til bag p& computeren
(eller tastaturet), og genstart
computeren, ndr nedlukningen
er feerdig.
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Afhjelpning af museproblemer (Forisat)

Problem Arsag Lesning

Musen reagerer ikke, Programmet, der er Sluk computeren med tastaturet,
ndr den flyttes, eller i brug, er holdt op og genstart derefter computeren.
den er for langsom. med at reagere pé

(fortsat) kommandoerne.

Musen skal muligvis
renses.

Tag kugledaekslet af musen, og rens
musens indvendige komponenter.

Musen skal muligvis
repareres.

Se vilkér og betingelser i den
verdensomspaendende begraensede
garanti.

Fejl i trédles enhed.

1. Kontroller enhedens status
i softwaren, hvis det er muligt.

2. Kontroller/udskift enhedens
batterier.

3. Nulstil modtageren og musen.

Computeren er
i standby.

Tryk pé& afbryderen for at genoptage
aktivitet fra standby.

A FORSIGTIG: Tryk ikke p& afbryderknappen i leengere tid end fire sekunder, nér du
forseger at genoptage fra standby. | modsat fald slukkes computeren, og du mister

alle data, som ikke er gemt.

Musen kan ikke bevaeges Musens kugle
lodret, vandret eller er snavset.
bevaegelsen sker i ryk.

Fiern kugledaekslet i bunden af
musen, og renger musen med et
rensesaet, der kan kebes i de fleste
computerforretninger.
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Afhjzelpning af problemer med installation

af hardware

Det kan vere ngdvendigt at rekonfigurere pc’en, nér du tilfgjer

eller fjerner hardware, som f.eks. et ekstra drev eller udvidelseskort.
Hyvis du installerer en Plug and Play-enhed, genkender Windows XP
automatisk enheden og konfigurerer computeren. Hvis du installerer

en enhed, der ikke understgtter plug and play, skal computeren

rekonfigureres, nar den nye hardware er installeret. Brug guiden

Tilfgj hardware i Windows XP, og fglg vejledningen pa skermen.

Afhjelpning af problemer med installation af hardware

Problem

Arsag

Losning

En ny enhed genkendes

ikke som en del af systemet.

Enheden er ikke isat
eller tilsluttet korrekt.

Serg for, at enheden er tilsluttet
korrekt, og at benene i kabelstikket
ikke er bojede.

Kablerne i den nye
eksterne enhed er lose,
eller stramkablerne

er ikke tilsluttet en
stremkilde.

Serg for, at alle kablerne sidder

korrekt, og at kablets eller stikkets
ikke er bojede.

Den nye enheds
afbryder stér ikke
pd teendt.

Sluk computeren, teend den eksterne
enhed, og teend derefter computeren
for at integrere enheden

i computersystemet.

Du accepterede ikke
systemets anbefaling
om at zendre
konfigurationen.

Genstart computeren, og felg
vejledningen for at acceptere
endringerne.

Et Plug and Play-kort
konfigureres ikke
automatisk, ndr

det tilfgjes, hvis
standardkonfigurationen
er i konflikt med andre
enheder.

Brug Enhedshéndtering i Windows XP
til at fraveelge de automatiske
indstillinger for kortet og veelge

en grundkonfiguration, der ikke
forarsager ressourcekonflikt. Du kan
ogsé lese ressourcekonflikten ved
at genkonfigurere eller deaktivere
enheder ved hjzelp af computerens
opsaetningsprogram.
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Afhjelpning af problemer med installation af hardware (Forisat)

Problem

Arsag

Losning

Computeren starter ikke.

Der blev brugt forkerte 1.

hukommelsesmoduler
til opgraderingen, eller
hukommelsesmodulerne
blev installeret det

forkerte sted. 9

Gennemgé den dokumentation,
der fulgte med systemet, for at
fastslé om du bruger de korrekte
hukommelsesmoduler, og om
installationen er korrekt.

. Hold @je med biplyde

og lysdiodernes signaler
p& computerens forside.
Se Appendiks A,
“POSTHejlmeddelelser” for

at finde de mulige é&rsager.

. Kontakt kundesupporttjenesten,

hvis du stadig ikke kan lese
problemet.

Den rede lysdiode for
strem blinker fem gange
pr. sekund, efterfulgt af

en pause pé to sekunder,
og computeren bipper fem
gange. (Bip-lydene stopper
efter femte gentagelse, men
lysdioderne bliver ved med

at blinke).

Hukommelsen er 1.

installeret forkert eller

fungerer ikke. 9

4,

Seet DIMM-modulerne i igen.
Teend systemet.

. Udskift DIMM-modulerne et ad

gangen for at isolere det modul,
der ikke fungerer.

. Udskift tredjepartshukommelse

med HP-hukommelse.
Udskift systemkortet.

Den rade lysdiode for
strom blinker seks gange
pr. sekund, efterfulgt aof

en pause pd to sekunder,
og computeren bipper seks
gange. (Bip-lydene stopper
efter femte gentagelse, men
lysdioderne bliver ved med

at blinke).

Grafikkortet er ikke
placeret korrekt eller 1
fungerer ikke, eller
systemkortet fungerer

ikke. 2.
3,

For systemer med et grafikkort:

. Seet grafikkortet rigtigt i.

Teend systemet.
Udskift grafikkortet.
Udskift systemkortet.

Udskift systemkortet, hvis systemet
har et integreret grafikkort.
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Afhjelpning af problemer med installation af hardware (Forisat)

Problem Arsag Lesning

Den rade lysdiode for Forkert tilbeherskort. 1. Kontroller alle tilbeherskort
stram blinker to gange ved at tage kortene ud (ét ad
pr. sekund, efterfulgt af gangen, hvis der er flere kort),
en pause pd to sekunder, og teend systemet for at se,

og computeren bipper ti om fejlen er rettet.

gange. (Bip-lydene stopper 2. Nér du har fundet det

efter femte gentagelse, men
lysdioderne bliver ved med

at blinke).

pagaeldende kort, skal du
tage det ud og udskifte det.

3. Udskift systemkortet.

Afhj®lpning af netveerksproblemer

Fglgende tabel indeholder almindelige arsager og lgsninger
pa problemer med netvark. Disse retningslinier handler ikke
om fejlfinding i netverkskabelfgringen.

Afhjzelpning af netveerksproblemer

Problem Arsag Losning

Funktionen Wake-on-LAN  Funktionen Wake-on-LAN  Aktiver funktionen Wake-on-LAN.
virker ikke. er ikke aktiveret. 1

. Veelg Start > Kontrolpanel.

2. Dobbeltklik p&
Netveaerksforbindelser.

3. Dobbeltklik p&
LAN-forbindelse.

4. Klik p& Egenskaber.

@]

. Klik p& Konfigurer.

6. Klik p& fanen Stremstyring,
og marker derefter
afkrydsningsfeltet Tillad,
at denne enhed szetter
computeren ud af standby.
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Afhjelpning af netvaerksproblemer (Forisat)

Problem

Arsag

Losning

Netvaerksdriveren
kan ikke finde

netvaerkscontrolleren.

Netvaerkscontrolleren
er deaktiveret.

1. Ker programmet til opszetning
af computeren, og aktiver
netvaerkscontrolleren.

2. Aktiver netvaerkscontrolleren
i operativsystemet via
Enhedsh&ndtering.

Forkert netvaerksdriver.

Se dokumentationen til
netvaerkscontrolleren vedrarende
den korrekte driver, eller hent den
nyeste driver pd producentens
hjemmeside.

Lampen for
netvaerksstatusforbindelse
blinker aldrig.

@, Lysdioden for
netvaerksstatus
skal blinke, nér
der er aktivitet
pé netvaerket.

Der er ikke fundet et aktivt
netvaerk.

Kontrollér kabelferingen og
netvaerksudstyret for korrekt
tilslutning.

Netvaerkscontrolleren
er ikke indstillet korrekt.

Kontroller enhedens status i Windows,
se f.eks. i Enhedsh&ndtering, om
driveren er indleest og status for den
aktuelle netveerksforbindelsesapplet
i Windows.

Netvaerkscontrolleren
er deaktiveret.

1. Ker programmet til opszetning
af computeren, og aktiver
netvaerkscontrolleren.

2. Aktiver netvaerkscontrolleren
i operativsystemet via
Enhedsh&ndtering.

Netvaerksdriveren er ikke
indlaest korrekt.

Geninstaller netveerksdriverne.

Se Vejledning til
netvaerkskommunikation pé
Dokumentation og diagnose-cd’en.

Systemet kan ikke foretage
autosense for netveerket.

Deaktiver autosense-egenskaberne,
og tving systemet ind i den korrekte
driftstilstand. Se Vejledning til
netvaerkskommunikation pé
Dokumentation og diagnose-cd’en.
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Afhjelpning af netvaerksproblemer (Forisat)

Problem

Arsag

Losning

Diagnosticeringen melder
om fejl.

Kablet er ikke tilsluttet
korrekt.

Serg for, at kablet sidder korrekt

i netvaerksstikket, og at den anden
ende af kablet er tilsluttet den
korrekte enhed.

Kablet er sat i det forkerte
stik.

Serg for, at kablet er tilsluttet det
korrekte stik.

Der er et problem med
kablet eller enheden i den
anden ende af kablet.

Serg for, at kablet eller enheden
i den anden ende fungerer korrekt.

Netvaerkscontrollerens
interrupt deles med
et udvidelseskort.

Skift indstillinger for kortets
ressourcer i menuen Advanced
i computerens opsaetningsprogram.

Netvaerkscontrolleren
er beskadiget.

Kontakt en autoriseret
tienesteudbyder.

Diagnosticeringen
melder ikke om fejl,
men computeren
kommunikerer ikke
med netvaerket.

Netvaerksdriverne

er ikke indlaest, eller
driverparametrene passer
ikke til den aktuelle
konfiguration.

Serg for, at netvaerksdriverne er
indleest, og at driverparametrene
passer til konfigurationen for
netvaerkscontrolleren.

Kontrollér, at den rigtige netveerksklient
og -protokol er installeret.

Netvaerkscontrolleren er
ikke konfigureret til denne
computer.

Veelg ikonet Netvaerk
i Kontrolpanel, og konfigurer
netvaerkscontrolleren.

Netveaerkscontrolleren
holdt op med at fungere,
da der blev fojet et
udvidelseskort il

Netvaerkscontrollerens
interrupt deles med et
udvidelseskort.

Skift indstillinger for kortets
ressourcer i menuen Advanced
i computerens opsaetningsprogram.

computeren.
Netvaerkscontrolleren Kontrollér, at driverne ikke blev
kreever drivere. slettet ved et uheld, da driverne
til det nye udvidelseskort blev
installeret.
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Afhjelpning af netvaerksproblemer (Forisat)

Problem

Arsag

Losning

Netvaerkscontrolleren
holdt op med at fungere,
da der blev fojet et
udvidelseskort til
computeren.

(fortsat)

Det installerede
udvidelseskort er et
netvaerkskort og i konflikt
med det integrerede
netvaerkskort.

Skift indstillinger for kortets
ressourcer i menuen Advanced
i computerens opsaetningsprogram.

Netvaerkscontrolleren
holder op med at fungere

uden nogen synlig 8rsag.

Filerne, der indeholder
netvaerksdriverne,
er beskadiget.

Geninstaller netvaerksdriverne ved
hjzelp af Restore Plus! cd’en.

Kablet er ikke tilsluttet
korrekt.

Serg for, at kablet sidder korrekt

i netvaerksstikket, og at den anden
ende af kablet er tilsluttet den
korrekte enhed.

Netveerkscontrolleren
er beskadiget.

Kontakt en autoriseret
tienesteudbyder.

Det nye netvaerkskort
vil ikke starte.

Det nye netvaerkskort
kan vaere defekt eller
opfylder méske ikke
industristandardens
specifikationer.

Installer et netvaerkskort,

der opfylder industristandarden, og
som virker, eller lad startsekvensen
starte fra en anden kilde.

Der kan ikke
etableres forbindelse
til netveerksserveren
ved forseg pé
fierninstallation.

Netvaerkscontrolleren er
ikke konfigureret korrekt.

Kontroller netveerkstilslutningen,

at en DHCP-server er til stede, og
at fiernsystemets installationsserver
indeholder driverne til netvaerkskortet.

Systemets
opsaetningsprogram
har rapporteret om en

uprogrammeret EEPROM.

Uprogrammeret EEPROM.

Kontakt en autoriseret
tienesteudbyder.
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Losning af hukommelsesproblemer

Hvis der opstéar problemer med hukommelsen, kan du finde nogle
almindelige arsager og lgsninger i tabellen nedenfor.

FORSIGTIG: HP understetter ikke en blanding af ECC- og ikke-ECC-
hukommelse pé& systemer, der understetter ECC-hukommelse. Ellers starter
computeren ikke operativsystemet.

Afhjzelpning af hukommelsesproblemer

Problem

Arsag

Losning

Systemet genstarter
ikke eller fungerer ikke
korrekt efter installation
af yderligere
hukommelsesmoduler.

Hukommelsesmoduleter
ikke den korrekte type
eller har ikke den rette
hastighed til systemet,
eller det er ikke placeret
korrekt.

Udskift modulet med en korrekt
enhed, der folger industristandarden
til computeren.

P& nogle modeller kan ECC- og
ikke-ECC-hukommelse ikke blandes.

Fejl pga. manglende
hukommelse.

Hukommelseskonfigurati
onen er muligvis ikke
indstillet korrekt.

Brug Enhedshéndtering
til at kontrollere
hukommelseskonfigurationen.

Der er ikke nok
hukommelse til at
kere programmet.

Kontrollér programdokumentationen
for at se kravet til hukommelse.

Hukommelsestest under

POST er ikke korrekt.

Hukommelsesmodulerne
er muligvis ikke
installeret korrekt.

Kontroller, at hukommelsesmodulerne
er installeret korrekt, og at de
korrekte moduler bruges.

Integreret grafik
kan bruge
systemhukommelsen.

Kraever ingen handling.

Fejlmeddelelse om
utilstraekkelig hukommelse
under programudferelse.

Der er for mange
TSR-programmer
(Terminate and Stay
Resident) installeret.

Slet unedvendige TSR-programmer.
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Afhjelpning af hukommelsesproblemer (Fortsat)

Problem

Arsag

Losning

Fejlmeddelelse om
utilstraekkelig hukommelse
under programudferelse.
(fortsat)

Der er ikke nok
hukommelse til at
kere programmet.

Kontroller programmets krav til
hukommelse, eller tiltaj mere
hukommelse i computeren.

Den rede lysdiode for
strem blinker fem gange
pr. sekund, efterfulgt af

en pause pé to sekunder,
og computeren bipper fem
gange. (Bip-lydene stopper
efter femte gentagelse, men
lysdioderne bliver ved med

at blinke).

Hukommelsen er
installeret forkert
eller fungerer ikke.

1. Seet DIMM-modulerne i igen.
Teend systemet.

2. Udskift DIMM-modulerne et ad
gangen for at isolere det modul,
der ikke fungerer.

3. Udskift tredjepartshukommelse
med HP-hukommelse.

4. Udskift systemkortet.

Afhjzelpning af processorproblemer

Hvis der opstar processorproblemer, kan du finde nogle almindelige
arsager og lgsninger i tabellen nedenfor.

Afhjelpning af processorproblemer

Problem

Arsag

Losning

Ydelsen er nedsat.

Processoren er varm.

1. Kontroller, at luftstrammen til
computeren ikke er blokeret.

2. Kontroller, at ventilatorerne
er tilsluttet og fungerer korrekt
(visse ventilatorer fungerer kun,
n&r der er behov for det).

3. Kontroller, at processorens
kelekappe er korrekt monteret.

Red lysdiode for strom
blinker tre gange pr.

sekund, efterfulgt of en
pause pd to sekunder.

Processoren er ikke
korrekt placeret eller
ikke installeret.

1. Kontroller, at processoren
er monteret.

2. Seet processoren i igen.

Vejledning til fejlfinding

www. hp.com

2-39
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Afhjzelpning af cd-rom- og dvd-problemer

Hvis der opstér problemer med cd-rom- eller dvd-drevet, kan du
se de almindelige arsager og lgsningerne i tabellen nedenfor eller

1 dokumentationen til enheden.

Afhjelpning af cd-rom- og dvd-problemer

Problem

Arsag

Losning

Systemet genstarter ikke fra

cd-rom- eller dvd-drevet.

Funktionen Removable
Media Boot er deaktiveret
i computerens
opsaetningsprogram.

Ker computerens opsaetningsprogram,
og aktiver boot fra flytbart medie

i Storage > Storage Options.
Kontroller, at IDE CD-ROM er aktiveret
i Storage > Boot Order.

Netvaerksservertilstanden
er aktiveret i computerens
opsaetningsprogram.

Ker computerens opsaetningsprogram,
og deaktiver Network Server
Mode i Security > Password
Options.

Der sidder en cd,
der ikke kan startes
fra, i drevet.

Seet en cd, der kan startes fra,
i drevet.

Startreekkefelgen er ikke
korrekt.

Ker computerens opsaetningsprogram,
og rediger startsekvensen i
Storage > Boot Order.

Cd-rom-eller dvd-enhederne

kan ikke findes, eller
driveren er ikke indleest.

Drevet er ikke tilsluttet
eller konfigureret
korrekt.

Se i dokumentationen til enheden.

Filmen kan ikke afspilles
i dvd-drevet.

Filmen har muligvis en
anden landekode.

Se i dokumentationen til dvd-drevet.

Der er ikke installeret
et dekoderprogram.

Installér et dekoderprogram.

Beskadiget medie.

Udskift mediet.

Filmens
tilladelsesniveau er 1&st
via forzeldrekontrollen.

Brug dvd-software til at fierne lasen.

Mediet er lagt forkert
i drevet.

Seet mediet i igen.
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Afhjelpning af cd-rom- og dvd-problemer (Fortsat)

Problem

Arsag

Losning

Cd’en kan ikke udskydes
(skuffe).

Cd’en sidder ikke

korrekt i drevet.

Sluk computeren, og szet en tynd
metalstang ind i nedudskydningshullet,
og tryk til. Traek langsomt skuffen
ud af drevet, indtil den er helt ude,
og tag derefter cd’en ud.

Cd-rom-, cd-rw-, dvd-rom-

eller dvd-r/rw-drevet kan
ikke laese en disk eller er
lzenge om at starte.

Mediet vender forkert.

Indszet mediet igen med etiketten
opad.

Dvd-rom-drevet er
leengere om at starte,
fordi det ferst skal
fastsld, hvilken type
medie der afspilles,

f.eks. lyd eller billede.

Vent mindst 30 sekunder pé, at
dvd-drevet finder ud of, hvilken
medietype der afspilles. Laes de
andre lesningsforslag i dette emne,
hvis drevet stadig ikke starter.

Cd’en eller dvd’en

er snavset.

Renger cd’en eller dvd’en med et
cd-rensesaet, som kan kebes i de
fleste computerforretninger.

Windows kan ikke
finde cd-rom- eller
dvd-rom-drevet.

1. Brug Enhedshdndtering til
at fierne eller afinstallere
den pagaeldende enhed.

2. Genstart computeren, og lad
Windows finde cd- eller

dvd-driveren.

Det er vanskeligt eller
umuligt at breende
musik-cd’er.

Der benyttes et forkert
medie, eller mediets
kvalitet er for ringe.

1. Forseg at optage med en lavere
hastighed.

2. Kontroller, at du bruger det
rigtige medie til drevet.

3. Forseg med et medie af et andet
maerke. Kvaliteten varierer fra
producent til producent.
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Afhjzelpning af drevkodeproblemer

Hvis der opstér problemer med drevkoden, kan du finde nogle
almindelige arsager og lgsninger i tabellen nedenfor.

Afhj=lpning af drevkodeproblemer

Problem Arsag Lesning

Drevkoden ses ikke som et Drevbogstavet efter det  Veelg et andet standarddrevbogstav
drevbogstav i Windows XP.  sidste fysiske drev er til drevkode i Windows XP.
ikke tilgeengeligt.

Computeren startes fra Der kan startes fra Installer forst drevkoden, nér
MS-DOS, efter at der drevkoden. operativsystemet er startet.
er lavet en drevkode,

der kan startes fra.

Losning af problemer med komponenter
péa frontpanelet

Hyvis der opstar problemer med enheder, der er tilsluttet frontpanelet,
kan du se de almindeligste arsager og lgsninger i tabellen nedenfor.

Lesning af problemer med komponenter péa frontpanelet

Problem Arsag Losning
En USB-enhed, Enheden er ikke tilsluttet 1. Sluk computeren.
hovedtelefoner eller en korrekt.

2. Tilslut enheden p& computerens

mikrofon er ikke genkend forside, og genstart computeren.

af computeren.

Enheden er méaske Hvis USB-enheden kreever
ikke tilsluttet vekselstrem, skal du kontrollere,
stramforsyningen. at den ene ende er tilsluttet

enheden, og den anden ende
er tilsluttet en stikkontakt.
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Lesning af problemer med komponenter péa frontpanelet (Forfsat)

Problem

Arsag

Losning

En USB-enhed,
hovedtelefoner eller

en mikrofon er ikke
genkendt af computeren.
(fortsat)

Den korrekte
enhedsdriver er
ikke installeret.

1. Installer den korrekte driver
for enheden.

2. Du skal muligvis genstarte
computeren.

Kablet mellem enheden
og computeren fungerer

ikke.

1. Udskift kablet, hvis det er muligt.

2. Genstart computeren.

Enheden fungerer ikke.

1. Udskift enheden.

2. Genstart computeren

Losning af problemer med at f& adgang

til internettet

Henvend dig til internetudbyderen, eller se de almindeligste arsager
og lgsninger i tabellen nedenfor, hvis der opstar problemer med
adgangen til internettet.

Lesning af problemer med at f& adgang til internettet

Problem

Arsag

Losning

Der kunne ikke oprettes
forbindelse til internettet.

Kontoen hos din
internetudbyder er ikke
konfigureret korrekt.

Kontroller internetindstillingerne,
eller kontakt udbyderen for at f&
hjeelp.

Modemet er ikke sat
korrekt op.

Tilslut modemet igen. Kontroller,
at tilslutningerne er korrekte ved
hjzelp af dokumentationen Hurtig
opsaetning.

Webbrowseren er ikke
konfigureret korrekt.

Kontroller, at webbrowseren er
installeret og sat op til at fungere
med internetudbyderen.

Kablet/DSL:modemet
er ikke tilsluttet.

Tilslut kablet/DSL-modemet.
En lysdiode for strom lyser p&
kabel/DSl-modemets forside.
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Lesning af problemer med at fa adgang til internettet (Fortsat)

Problem

Arsag

Losning

Der kunne ikke oprettes
forbindelse til internettet.
(fortsat)

Kabel/DSLjenesten er
ikke tilgeengelig eller er
blevet afbrudt p& grund
af dérlige vejrforhold.

Forseg at oprette forbindelse til
infernettet pd et senere tidspunkt,
eller kontakt internetudbyderen.
(Hvis der er forbindelse til kabel/
DSL-jenesten, lyser lysdioden for
forbindelse pé& kabel/DSL-modemets

forside).

CAT5 UTP-kablet er ikke
tilsluttet.

Tilslut CAT5 UTP-kablet mellem
kabelmodemet og computerens
RJ-45-stik. (Hvis der er forbindelse,
lyser lysdioden for pc’en pd
kabel/DSL-modemets forside).

IP-adressen er ikke
konfigureret korrekt.

Kontakt internetudbyderen for at té&
oplyst den rette IP-adresse.

Cookies er beskadigede.

(En “cookie” er en lille
maengde oplysninger,
som en webserver kan
gemme midlertidigt

i webbrowseren.

Det er nyttigt at bevare
specifikke oplysninger,
som webserveren
derefter kan hente p&
et senere tidspunkt).

| Windows XP:
1. Veelg Start > Kontrolpanel.

2. Dobbeltklik p&
Internetindstillinger.

3. Klik p& knappen Slet cookies
under fanen Generelt.

Internetprogrammer kan
ikke startes automatisk.

Visse programmer
kan ferst startes, nér
du er logget p& hos
internetudbyderen.

Log pé hos internetudbyderen,
og start det enskede program.
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Lesning af problemer med at fa adgang til internettet (Fortsat)

Problem

Arsag

Losning

Internettet er for leenge om
at overfere websteder.

Modemet er ikke sat
korrekt op.

Kontroller, at den korrekte
modemhastighed og COM-port

er valgt.

| Windows XP:

1.

2.
3.
4.

Velg Start > Kontrolpanel.
Dobbeltklik p& System.
Klik p& fanen Hardware.

Klik p& knappen
Enhedshéandtering i
omrédet Enhedshéndtering.

. Dobbeltklik p& Porte

(COM & LPT).

. Hojreklik p& den COM-port,

som modemet benytter, og klik
derefter p& Egenskaber.

" Kontroller under Status for

enheden, at modemet
fungerer korrekt.

. Kontroller under Brug af

enheden, at modemet er
aktiveret.

. Klik p& knappen Fejlfind, og

felg vejledningen pé& skaermen,
hvis der er flere problemer.
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Afhjzelpning af problemer med software

De fleste softwareproblemer opstéar pa grund af fglgende:

B Programmet blev ikke installeret eller konfigureret korrekt.
B Der er ikke nok hukommelse til at kgre programmet.

B Der er en programkonflikt.

B Sgrg for, at alle ngdvendige enhedsdrivere er installeret.

B Huvis du har installeret et andet operativsystem end det, der var

installeret fra fabrikken, skal du kontrollere, at det understgttes
af dit system.

Hvis der opstar softwareproblemer, kan du finde mulige 1gsninger
i nedenstaende tabel.

Afhjelpning af softwareproblemer

Problem Arsag Lesning

Computeren fortszetter ikke,  Der opstod en POST-ejl.  Hold @je med biplyde og

og der vises infet HP-logo lysdiodernes signaler p&

p& skaermen. computerens forside. Se Appendiks A,

“POST-ejlmeddelelser” for at finde
de mulige &rsager.

Se vilkér og betingelser i Restore Kit
eller i den verdensomspaendende
begraensede garanti.

Computeren fortszetter ikke, ~ Systemfilerne er muligvis ~ Brug genoprettelsesdisketten til at
efter at HP-logoet har veeret  beskadigede. gennemsege harddisken for fejl.
vist p& skaermen.

Der vises en meddelelse Den software, Kontroller, at softwaren er godkendt
om, at der er foretaget en  der benyttes, er ikke af Microsoft til den pagaeldende
ugyldig handling. godkendt af Microsoft  version af Windows (disse oplysninger
til den pageeldende findes p& programpakken).
version af Windows.
Konfigurationsfilerne Gem alle data, luk alle programmer,
er beskadiget. og genstart computeren, hvis det er
muligt.
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Kontakt kundesupport

Kontakt en autoriseret forhandler eller serviceudbyder for at fa hjelp
og vejledning. Besgg www.hp.com for at finde en forhandler eller
serviceudbyder i narheden.

% Hyvis du indleverer computeren til service hos en autoriseret
forhandler eller serviceudbyder, skal du huske at udlevere
adgangskoderne for start og ops@tning, hvis de er defineret.

% Se nummeret, der er anfgrt i garantien, eller i vejledningen
Telefonnumre til teknisk support pd Dokumentation og
diagnose-cd’en for at fa oplysninger om teknisk support.
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POST-fejlmeddelelser

Dette appendiks handler om de fejlkoder, fejlmeddelelser og forskellige
indikatorlysdioder og lydalarmer, der muligvis fremkommer under
POST (Power-On Self-Test) eller computergenstart, de mulige
arsager til problemet, og hvad du kan ggre for at udbedre fejlene.

Deaktivering af POST-meddelelser undertrykker de fleste
systemmeddelelser under POST, f.eks. optelling af hukommelsen
og tekstmeddelelser, der ikke omhandler fejl. Hvis der opstér en
POST-fejl, vises fejlmeddelelsen pa skermen. Du kan manuelt skifte
til aktivering af POST-meddelelser ved at trykke pa en vilkarlig tast
(undtagen F10 og F12). Standarden er deaktivering af POST-
meddelelser.

Hastigheden for indlesning af operativsystemet og omfanget af tests
bestemmes af valget af POST-tilstand.

Quick Boot er en hurtig startproces, der ikke kgrer alle test pa
systemniveau, f.eks. hukommelsestest. Full Boot kgrer alle
ROM-baserede systemtests og tager lengere tid at udfgre.

Full Boot kan ogsa aktiveres til at kgre regelmassigt fra hver dag

til hver 30. dag i en planlagt periode. Rekonfigurér computeren til
Full Boot hver x dag ved hjelp af computerens ops@tningsprogram,
hvis du vil oprette en tidsplan.

% Se opseetningsvejledningen (F10) pa Dokumentation og diagnose-
cd’en for at fa flere oplysninger om computerens ops&@tningsprogram.
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POST-ejlmeddelelser

Numeriske POST-koder og tekstmeddelelser

Dette afsnit beskriver de POST-fejl, hvortil der er knyttet numeriske
koder. Dette afsnit indeholder desuden en raekke tekstmeddelelser,
der muligvis vises under POST.

% Computeren bipper en gang, efter en POST-tekstmeddelelse vises
pa skarmen.

Numeriske koder og tekstmeddelelser

Kode/Meddelelse Mulig é@rsag Anbefalet handling

101-Option ROM Systemhukommelsens 1. Bekreeft, at ROM’en er korrekt.

Checksum Error eller udvidelseskortets 2. Flash ROM'en, hvis det er nadvendigt.
indstilling for '

3. Hvis der for nylig er tilfojet et
udvidelseskort, skal det fiernes for
at konstatere, om det er rsagen
til problemet.

4. Ryd CMOS. (Se ogsé Appendiks B,
“Sikkerhed med adgangskode
og nulstilling af CMOS.")

5. Hvis meddelelsen forsvinder,
er der muligvis et problem
med udvidelseskortet.

6. Udskift systemkortet.

103-System Board DMA eller timere. 1. Ryd CMOS. (Se ogs& Appendiks B,
Failure “Sikkerhed med adgangskode
og nulstilling af CMOS.")

2. Fjern alle udvidelseskort.
3. Udskift systemkortet.

hukommelseschecksum.
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POST-ejlmeddelelser

Numeriske koder og tekstmeddelelser (Fortsat)

Kode/Meddelelse

Mulig érsag

Anbefalet handling

110-Out of Memory
Space for Option
ROMs

Et PCl-udvidelseskort,
der for nylig er installeret,
indeholder en ekstra
ROM, der er for stor til

at kunne overfares via

POST.

1. Hvis der for nylig er tilfojet et
PCl-udvidelseskort, skal det fiernes
for at konstatere, om det er &rsagen
til problemet.

2. G& ind i computerens
opseetningsprogram, og indstil
Advanced > Device Options >
NIC PXE Option ROM
Download til DISABLE for at
forhindre, at PXE-indstillingen ROM
for det interne netveerkskort overfores
under POST, s& der frigeres mere
hukommelse til et udvidelseskorts
ekstra ROM. Den interne PXE-indstilling
ROM bruges til at genstarte fra
netvaerkskortet til en PXE-server.

3. Kontroller, at ACPI/USB Buffers
ved Top of Memory i computerens
opseetningsprogram er aktiveret.

162-System Options
Not Set

Konfigurationen
er forkert.

Batteriet il realtidsuret
skal muligvis skiftes.

Ker computerens opsaetningsprogram,
og kontroller konfigurationen under
Advanced > Onboard Devices.

Stil dato og klokkeslzet i Kontrolpanel.
Hvis problemet fortszetter, skal du
udskifte batteriet til realtidsuret. Se
Hardwarevejledningen p& Dokumentation
og diagnose-cd’en for at {8 vejledning

i iseetning af et nyt batteri, eller kontakt
en autoriseret forhandler for at f& udskiftet
batteriet til realtidsuret.

Vejledning til fejlfinding
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POST-ejlmeddelelser

Numeriske koder og tekstmeddelelser (Fortsat)

Kode/Meddelelse Mulig é@rsag

Anbefalet handling

163-Time & Date
Not Set

Ugyldig dato eller
klokkesleet i konfigurati-
onshukommelsen.

Batteriet til realtidsuret
skal muligvis udskiftes.

Nulstil dato og klokkesleet under
Kontrolpanel (computerens
opsaetningsprogram kan ogsé bruges).
Hvis problemet fortszetter, skal du
udskifte batteriet til realtidsuret. Se
Hardwarevejledningen p& Dokumentation
og diagnose-cd’en for at f& vejledning

i iseetning af et nyt batteri, eller kontakt
en autoriseret forhandler for at {& udskiftet
batteriet til realtidsuret.

CMQOS-jumperen er
muligvis ikke korrekt
placeret.

Kontrollér eventuelt, om CMOS-jumperen
sidder rigtigt.

164-Memory Size
Error

Hukommelsens sterrelse
er sendret siden den
seneste start (der er
tilfojet eller fiernet
hukommelse).

Tryk pé tasten F1 for at gemme
sendringerne af hukommelsen.

Hukommelsen er
konfigureret forkert.

1. Ker computerens opsaetningsprogram
eller et Windows-hjeelpeprogram.

2. Kontroller, at hukommelsesmodulerne
er installeret korrekt.

3. Kor testen med hukommelse fra HP
alene, hvis der er tilfojet hukommelse
fra en anden leverander.

4. Kontrollér, at du bruger den rigtige
type hukommelsesmodul.

A-4
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POST-ejlmeddelelser

Numeriske koder og tekstmeddelelser (Fortsat)

Kode/Meddelelse Mulig é@rsag

Anbefalet handling

2071-Memory Error

RAMejl.

1.

Ker computerens opsaetningsprogram
eller et Windows-hjeelpeprogram.

. Kontroller, at hukommelsesmodulerne

er installeret korrekt.

. Kontrollér, at du bruger den rigtige

type hukommelsesmodul.

. Fiern og udskift den eller de

identificerede hukommelsesmoduler,
hvor der er opstéet fejl.

. Hvis fejlen ikke er afhjulpet, nér

hukommelsesmodulerne er udskiftet,
skal systemkortet udskiftes.

213-Incompatible
Memory Module in
memory Socket(s)

’ y e

Et hukommelsesmodul

i hukommelsesstikket,
der er angivet i
fejlmeddelelsen, mangler
vigtige SPD-oplysninger
eller er inkompatibelt
med chipszettet.

. Kontrollér, at du bruger den rigtige

type hukommelsesmodul.

. Prov et andet hukommelsesstik.
. Udskift DIMM-modulet med ét,

der overholder SPD-standarden.

214-DIMM
Configuration
Warning

Den anvendte
DIMM:-konfiguration
er ikke optimeret.

Omarranger DIMM-modulerne, sé& hver
kanal har samme maengde hukommelse.

219-ECC Memory
Module Detected

ECC Modules not
supported on this

Platform

Hukommelsesmoduler,
der er tilfajet for nylig,
understetter fejlretning
af ECC-hukommelsen.

1.

2.

Hvis der for nylig er tilfojet ekstra
hukommelse, skal den fjernes for
at se, om problemet fortsaetter.

Se i produktdokumentationen for
at f& oplysninger om understettelse
af hukommelse.

Vejledning til fejlfinding
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POST-ejlmeddelelser

Numeriske koder og tekstmeddelelser (Fortsat)

Kode/Meddelelse Mulig é@rsag

Anbefalet handling

301-Keyboard Error

Tastaturfejl.

1.

Tilslut tastaturet igen, mens der
er slukket for computeren.

. Kontrollér stikket for bejede eller

manglende ben.

. Kontrollér, at ingen taster

er trykket ned.

. Udskift tastaturet.

303-Keyboard
Controller Error

|/ O-kortets
tastaturcontroller.

. Tilslut tastaturet igen, mens der

er slukket for computeren.

. Udskift systemkortet.

304-Keyboard or
System Unit Error

Tastaturfejl.

. Tilslut tastaturet igen, mens der

er slukket for computeren.

. Kontrollér, at ingen taster

er trykket ned.

. Udskift tastaturet.

4. Udskift systemkortet.

404-Parallel Port
Address Conflict
Detected

B&de den eksterne og
den interne port er tildelt
den parallelle port X.

. Fiern alle kort til udvidelse af

parallelporten.

. Ryd CMOS. (Se ogsé Appendiks B,

“Sikkerhed med adgangskode
og nulstilling af CMOS.")

. Rekonfigurér kortressourcerne,

og/eller ker computerens
opsaetningsprogram.

410-Audio Interrupt
Conflict

Der er opst&et en konflikt
mellem IRQ-adressen og
en anden enhed.

Ker computerens opsaetningsprogram,
og nulstil IRQ under Advanced >
Onboard Devices.

411-Network
Interface Card
Interrupt Conflict

Der er opst&et en konflikt
mellem IRQ-adressen og
en anden enhed.

Ker computerens opsaetningsprogram,
og nulstil IRQ under Advanced >
Onboard Devices.

A-6
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Numeriske koder og tekstmeddelelser (Fortsat)

Kode/Meddelelse Mulig é@rsag

Anbefalet handling

501-Display
Adapter Failure

Grafikcontrolleren.

1.

2.

4.

Seet grafikkortet i igen, (hvis det
er relevant).

Ryd CMOS. (Se ogsd Appendiks B,
“Sikkerhed med adgangskode
og nulstilling af CMOS.”)

. Bekraeft, at skeermen er tilsluttet

og teendt.

Seet grafikkortet i igen (hvis det
er muligt).

510-Flash Screen
Image Corrupted

Flash Screen-billedet
indeholder fejl.

Flash systemhukommelsen igen med den
seneste BIOS.

511-CPU, CPUA,
or CPUB Fan not

CPU-ventilatoren er ikke
tilsluttet eller fungerede

1.

Installer CPU-ventilatoren igen.

. Installer ventilatorkablet igen.

2
Detected ikke korrekt.

3. Udskift CPU-ventilatoren.
512-Chassis, Rear Kabinettets ventilator, 1. Installer kabinettets ventilator igen,
Chassis, or Front bag pé& kabinettet eller bag pé kabinettet eller foran pé
Chassis Fan not foran pd kabinettet, kabinettet.

Detected er ikke hls"fﬂet eller 2. Installer ventilatorkablet igen.
fungerede ikke. ) ) ) .
3. Udskift kabinettets ventilator, bag pé
kabinettet eller foran pé& kabinettet.
514-CPU or Chassis ~ CPU- eller 1. Installer CPU- eller kabinetventilatoren
Fan not Detected kabinetventilatoren igen.
er ikke “lSh.mef eller 2. Installer ventilatorkablet igen.
fungerede ikke korrekt. ) _ )

3. Udskift CPU- eller kabinetventilatoren.
601-Diskette Der er fejl i ledningsnettet 1. Kar computerens opsaetningsprogram.
Controller Error til dlskfattecontrolleren 2. Kontrollér og/eller udskift kablere.

eller diskettedrevet. .
3. Ryd CMOS. (Se ogsd Appendiks B,
“Sikkerhed med adgangskode
og nulstilling af CMOS.")
4. Udskift diskettedrevet.
5. Udskift systemkortet.

Vejledning til fejlfinding
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Numeriske koder og tekstmeddelelser (Fortsat)

Kode/Meddelelse Mulig é@rsag Anbefalet handling
605-Diskette Drive Uoverensstemmelse 1. Ker computerens opsaetningsprogram.
Type Error i drevtypen. 2. Afbryd alle andre
diskettecontrollerenheder (b&nddrev).
3. Ryd CMOS. (Se ogsé Appendiks B,
“Sikkerhed med adgangskode
og nulstilling of CMOS.”)
610-External Det eksterne banddrev Installér b&nddrevet igen, eller tryk p& F1,
Storage Device er ikke tilsluttet. og lad systemet rekonfigurere uden drevet.
Failure

611-Primary Floppy

Konfigurationsfejl.

Ker computerens opsaetningsprogram,

Port Address og kontroller konfigurationen under
Assignment Conflict Advanced > Onboard Devices.
660-Display cache ~ Den integrerede Udskift systemkortet, hvis minimal

is detected unreliable

grafikcontrollers
skaermcache fungerer
ikke korrekt og
deaktiveres.

forringelse af grafikken er et problem.

912-Computer
Cover Has Been
Removed Since Last
System Startup

Computerens deekplade
har veeret fiernet siden
sidste systemstart.

Kraever ingen handling.

917-Front Audio Not
Connected

Det forreste ledningsnet
til lyd er losnet eller
fiernet fra bundkortet.

Tilslut eller monter det forreste ledningsnet
til lyd igen.

918-Front USB Not
Connected

Det forreste ledningsnet
til USB er losnet eller
fiernet fra bundkortet.

Tilslut eller monter det forreste ledningsnet
til USB igen.

919-Multi-Bay Riser
not Connected

Udvidelseskortet er
fiernet eller er ikke
korrekt geninstalleret
i systemet.

Seet udvidelseskortet i igen.

A-8
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Numeriske koder og tekstmeddelelser (Fortsat)

Kode/Meddelelse

Mulig érsag

Anbefalet handling

92 1-Device in PCI
Express-stikket kunne
ikke initialiseres

Der er inkompatibilitet/
problemer med denne
enhed, og systemet eller
PCI Express Link kunne

ikke omdannes til en x1.

Forseg at genstarte systemet. Hvis fejlene
opstdr igen, kan enheden ikke fungere
sammen med dette system.

1151-Serial Port A
Address Conflict
Detected

B&de den eksterne og
den interne port er tildelt
til COM1.

1. Fjern alle kort il udvidelse af den
serielle port.

2. Ryd CMOS. (Se ogsé& Appendiks B,
“Sikkerhed med adgangskode
og nulstilling of CMOS.")

3. Rekonfigurér kortressourcerne, og/eller
ker computerens opszetningsprogram
eller Windows-hjeelpeprogrammerne.

1152-Serial Port B
Address Conflict
Detected

B&de den eksterne og
den inferne port er tildelt

til COM2.

1. Fjern alle kort til udvidelse af den
serielle port.

2. Ryd CMOS. (Se ogsé& Appendiks B,
“Sikkerhed med adgangskode
og nulstilling af CMOS.”)

3. Rekonfigurér kortressourcerne, og/eller
ker computerens opsaetningsprogram
eller Windows-hjzelpeprogrammerne.

1155-Serial Port
Address Conflict
Detected

B&de den eksterne og
den interne port er tildelt
til samme IRQ.

1. Fjern alle kort til udvidelse af den
serielle port.

2. Ryd CMOS. (Se ogsé& Appendiks B,
“Sikkerhed med adgangskode
og nulstilling af CMOS.")

3. Rekonfigurér kortressourcerne, og/eller
ker computerens opsaetningsprogram
eller Windows-hjselpeprogrammerne.

1201-System Audio
Address Conflict
Detected

Der er opst&et en konflikt
mellem enhedens
IRQ-adresse og en anden

enhed.

Ker computerens opsaetningsprogram,
og nulstil IRQ under Advanced >
Onboard Devices.

Vejledning til fejlfinding
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Numeriske koder og tekstmeddelelser (Fortsat)

Kode/Meddelelse

Mulig érsag

Anbefalet handling

1202-MIDI Port
Address Conflict
Detected

Der er opst@et en
konflikt mellem enhedens
IRQ-adresse og en anden

enhed.

Ker computerens opszetningsprogram,
og nulstil IRQ under Advanced >
Onboard Devices.

1203-Game Port
Address Conflict
Detected

Der er opst&et en konflikt
mellem enhedens
IRQ-adresse og en anden

enhed.

Kor computerens opsaetningsprogram,
og nulstil IRQ under Advanced >
Onboard Devices.

1720-SMART Hard
Drive Detects
Imminent Failure

Der er ved at opstd

en fejl p& harddisken.
Nogle harddiske har en
firmwareprogramrettelse
til harddisken, der retter
en fejlagtig fejlmeddelelse.

1. Find ud af, om harddisken giver korrekte

fejlmeddelelser. Ker computerens
opseetningsprogram, og ker testen
Drive Protection System under
Storage > DPS Self-test.

2. Anvend firmwareprogramrettelsen
til harddisken, hvis det er relevant.
(Findes p& www.hp.com/support).

3. Sikkerhedskopiér indholdet, og udskift

harddisken.

1785-MultiBay er
installeret forkert

(integrerede MultiBay/
USDT-systemer)

1. MultiBay-enheden er
ikke placeret korrekt.

2. MultiBay-udvidelseskort
et er ikke placeret
korrekt.

1. Kontroller, at MultiBay-enheden er sat

helt i.

2. Kontroller, at MultiBay-udvidelseskortet

er korrekt monteret.

www.hp.com
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Numeriske koder og tekstmeddelelser (Fortsat)

Kode/Meddelelse

Mulig érsag

Anbefalet handling

1794-Inaccessible
devices attached to
SATA 1 and/or
SATA 3

En enhed er fastgjort fil
SATA 1 og/eller SATA 3.
Enheder, der er fastgjort
til disse stik, er ikke
tilgeengelige, nér “SATA
Emulation” er indstillet il
“Combined IDE Controller”
i computerens
opsaetningsprogram.

1. Hvis du kerer Windows 2000 eller
Windows XP, skal du sendre “SATA
Emulation” til “Separate IDE Controller”
i computerens opsaetningsprogram.

2. Hvis du ikke kerer Windows 2000
eller Windows XP, skal du flytte de
pdgaeldende enheder til SATA O
eller SATA 2 (hvis muligt).

3. Fiern de pdgzeldende enheder fra
SATA 1 og SATA 3.

1796-SATA Cabling

Error

En eller flere SATA-enheder
er forkert fastgjorte. Der
opnds optimal ydeevne,
hvis SATA 0- og SATA 1

-stikkene bruges for
SATA 2 og SATA 3.

Kontroller, at SATA-stikkene bruges i
opadgéende raekkefolge. Til én enhed
skal du bruge SATA 0. Brug SATA O
og SATA 1 til to enheder. Brug SATA O,
SATA 1 og SATA 2 til tre enheder.

1801-Microcode
Patch Error

Processoren understottes

ikke af ROM BIOS’en.

1. Opgradér BIOS en til en korrekt

version.

2. Udskift processoren.

Ugyldigt elektronisk

serienummer

Det elektroniske
serienummer er

beskadiget.

1. Ker computerens opsaetningsprogram.
Hvis programmet til opszetning af
computeren allerede indeholder data
i feltet eller ikke tillader angivelse
af serienummeret, skal du hente
og kere SP5572.EXE (SNZERO.EXE),

som du finder p& www.hp.com.

2. Ker computerens opsaetningsprogram,
og forseg at indtaste serienummeret
under Security, System ID, og gem
derefter sendringerne.

Vejledning til fejlfinding
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Numeriske koder og tekstmeddelelser (Fortsat)

Kode/Meddelelse Mulig é@rsag Anbefalet handling
Netvaerksservertilsta  Tastaturfejl, mens 1. Tilslut tastaturet igen, mens der
nd aktiv, og intet netveerksservertilstanden er slukket for computeren.
tastatur er filsluttef er akfiveref. 2. Kontrollér stikket for bajede eller

manglende ben.

3. Kontrollér, at ingen taster
er trykket ned.

4. Udskift tastaturet.

Paritetscheck 2

Systemet starter ikke
uden en ventilator

RAM-paritetsfe;l. Ker computerens opsaetningsprogram

og diagnosticeringsprogrammerne.
CPU-ventilator er ikke 1. Abn laget, tryk p& afbryderen, og
installeret eller afbrudt kontroller, at processorens ventilator
i VSFF-kabinettet. drejer rundt. Hvis processorens

ventilator ikke drejer rundt, skal

du kontrollere, at ventilatorkablet

er tilsluttet systemkortets header.
Kontroller, at keleklappen er placeret
og installeret korrekt.

2. Hvis ventilatoren er tilsluttet og
keleklappen er placeret korrekt,
men ventilatoren ikke kerer, skal du
udskifte ventilatoren og keleklappen.

www.hp.com Vejledning til fejlfinding



POST-ejlmeddelelser

Frontpanelets lysdioder og herbare alarmer
til POST-diagnosticering

Dette afsnit omhandler frontpanelets lysdiodekoder tillige med
hgrbare alarmer, der kan forekomme fgr eller under POST, men som
ikke ngdvendigvis er knyttet til en fejlkode eller tekstmeddelelse.

S

SN

Hvis lysdioder blinker pa et PS/2-tastatur, skal du holde gje med
blinkende lysdioder pa computerens frontpanel og se i tabellen
nedenfor for at tolke frontpanelets lysdiodekoder.

De anbefalede handlinger i tabellen nedenfor er anfgrt i den
rekkefglge, som de skal udfgres i.

Frontpanelets lysdioder og herbare alarmer til diagnosticering

Aktivitet Bip Mulig érsag Anbefalet handling

Den grenne Ingen  Computeren Ingen

lysdiode for er teendt.

strom lyser.

Den grenne Ingen  Computeren er i Ingen er pdkraevet. Tryk p& en vilkérlig

lysdiode for strem
blinker hvert andet
sekund.

Skifttil RAM-ilstand  tast, eller flyt musen for at vaekke
(kun visse modeller)  computeren.
eller almindelig

standby.

Vejledning til fejlfinding
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POST-ejlmeddelelser

Frontpanelets lysdioder og herbare alarmer til diagnosticering (Fortsat)

Aktivitet Bip Mulig é@rsag Anbefalet handling
Red lysdiode for 2 Processorens 1. Serg for, at computerens
strom blinker to termiske beskyttelse ventilationshuller ikke er blokeret,
gange pr. sekund, er aktiveret: og at processorens kaleventilator
efterfulgt af en pause En ventilator er kerer.
pa flocj,ekunder. muligvis blokeret 2. Abn l&get, tryk p& afbryderen, og
Bip-lydene stopper eller drejer ikke kontroller, at processorens ventilator
efter femlfe rundt. drejer rundt. Hvis processorens
lgegt.oge s€, l:n:l?n ELLER ventilator ikke drejer rundt, skal
ysdioderne biiver du kontrollere, at ventilatorkablet
ved med at blinke, Kolekappen/ er tilsluttet systemkortets head
vead ilatoren er ystemkortets header.
indtil problemet er ven I |
ikk Kontroller, at ventilatoren er
lost e montere! laceret eller installeret korrekt
korrekt pa placeret eller installeret korrekt.
processoren. 3. Hvis processorventilatoren er
tilsluttet og placeret korrekt,
men ikke drejer rundt, skal du
udskifte den.

4. Seet processorens keleklap pé igen,
og kontroller, at ventilatoren er
monteret korrekt.

5. Kontakt en autoriseret forhandler
eller serviceyder.

Red lysdiode for 3 Processoren er 1. Kontroller, at processoren
strem blinker tre ikke installeret er monteret.
gange pr. sekund, (angiver ikke 2. Seet processoren i igen.

efterfulgt of en pause
pé to sekunder.
Bip-lydene stopper
efter femte
gentagelse, men
lysdioderne bliver
ved med at blinke,
indtil problemet er
|ost.

en beskadiget
processor).

www.hp.com
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POST-ejlmeddelelser

Frontpanelets lysdioder og herbare alarmer til diagnosticering (Fortsat)

Aktivitet Bip Mulig arsag

Anbefalet handling

Red lysdiode for 4
strem blinker fire
gange pr. sekund,
efterfulgt af en pause
pé to sekunder.
Bip-lydene stopper
efter femte
gentagelse, men
lysdioderne bliver
ved med at blinke,
indtil problemet er
|ost.

Stremsvigt
(stremforsyningen
er overbelastet).

1. Abn l&get, og kontroller, at
stremforsyningskablet med 4
eller 6 ledere er tilsluttet stikket
p& systemkortet.

2. Kontroller, om en enhed for&rsager

problemerne, ved at fierne ALLE
tilsluttede enheder (f.eks. harddisk,
diskettedrev eller optiske drev og
udvidelseskort). Teend systemet.
Hvis systemet skifter til POST, skal
du slukke og udskifte en enhed ad
gangen og gentage proceduren,
indtil fejlen forekommer. Udskift
den enhed, der forérsager fejlen.
Fortszet med at tilfeje enhederne
én ad gangen for at sikre, at alle
enheder fungerer korrekt.

3. Udskift stramforsyningen.
4. Udskift systemkortet.

Red lysdiode for 5
strem blinker fem
gange pr. sekund,
efterfulgt af en pause
pé to sekunder.
Bip-lydene stopper
efter femte
gentagelse, men
lysdioderne bliver
ved med at blinke,
indtil problemet er
|ost.

Hukommelsesfejl
for videomodul.

1. Seet DIMM-modulerne i igen.

Teend systemet.

2. Udskift DIMM-modulerne et ad

gangen for at isolere det modul,
der ikke fungerer.

3. Udskift tredjepartshukommelse

med HP-hukommelse.

4. Udskift systemkortet.

Vejledning til fejlfinding
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Frontpanelets lysdioder og herbare alarmer til diagnosticering (Fortsat)

Aktivitet

Bip Mulig arsag

Anbefalet handling

Red lysdiode for
strem blinker seks
gange pr. sekund,
efterfulgt af en pause
pé to sekunder.
Bip-lydene stopper
efter femte
gentagelse, men
lysdioderne bliver
ved med at blinke,
indtil problemet er
|ost.

6 Grafikfejl for

videomodul.

For systemer med et grafikkort:

1. Seet grafikkortet rigtigt i.
Teend systemet.

2. Udskift grafikkortet.
3. Udskift systemkortet.

Udskift systemkortet, hvis systemet har
et integreret grafikkort.

Red lysdiode for
strom blinker syv
gange pr. sekund,
efterfulgt af en pause
pé to sekunder.
Bip-lydene stopper
efter femte
gentagelse, men
lysdioderne bliver
ved med at blinke,
indtil problemet er
|ost.

7 Fejl p& systemkortet
(fejl sporet i ROM
for skeermmodulet).

Udskift systemkortet.

Red lysdiode for
strem blinker otte
gange pr. sekund,
efterfulgt of en pause
pé to sekunder.
Bip-lydene stopper
efter femte
gentagelse, men
lysdioderne bliver
ved med at blinke,
indtil problemet er
|ost.

8 Ugyldig ROM
baseret pd forkert
checksum.

1. Flash systemhukommelsen igen med
den seneste BIOS. Se afsnittet “Boot
Block Emergency Recovery Mode” i
Vejledning til desktopadministration
p& Dokumentation og diagnose-cd’en
for at f& flere oplysninger.

2. Udskift systemkortet.

www.hp.com
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POST-ejlmeddelelser

Frontpanelets lysdioder og herbare alarmer til diagnosticering (Fortsat)

Aktivitet Bip Mulig é@rsag Anbefalet handling

Red lysdiode for 9 Systemet teender, 1. Kontroller, at spaendingsvaelgeren
strom blinker ni men kan ikke bag pé& stremforsyningen (pé& visse
gange pr. sekund, starte. modeller) er angivet til den rette
efterfulgt af en pause speending. Den rette indstilling af
pé to sekunder. speendingen afhaenger af det
Bip-lydene stopper aktuelle omréde.

efter femte . Udskift systemkortet.

gentagelse, men .

lysdioderne bliver . Udskift processoren.

ved med at blinke,

indtil problemet

er lost.

Red lysdiode for 10 Forkert . Kontroller alle tilbeherskort ved at

strem blinker ti
gange pr. sekund,
efterfulgt af en pause
pé to sekunder.
Bip-lydene stopper
efter femte
gentagelse, men
lysdioderne bliver
ved med at blinke,
indtil problemet
er lost.

tilbeherskort.

tage kortet ud (ét ad gangen hvis
der er flere kort), og teend systemet
for at se, om fejlen er rettet.

. N&r du har fundet det pdgzeldende

kort, skal du tage det ud og udskifte
det.

. Udskift systemkortet.

Vejledning til fejlfinding
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POST-ejlmeddelelser

Frontpanelets lysdioder og herbare alarmer til diagnosticering (Fortsat)

Aktivitet Bip

Mulig é@rsag

Anbefalet handling

Systemet teendes Ingen
ikke, og lysdioderne
blinker ikke.

Systemet kunne
ikke teendes.

Tryk p& og hold afbryderen nede
i mindre end fire sekunder. Hvis
harddiskens lysdioder lyser grent,
skal du gere felgende:

1. Kontroller, at spaendingsvaelgeren
bag pé stremforsyningen er angivet
til den rette spaending. Den rette
indstilling aof speendingen afhaenger
af det aktuelle omréde.

2. Fjern udvidelseskortene et
ad gangen, indtil lysdioden
5 V_aux pé systemkortet lyser.

3. Udskift systemkortet.
ELLER

Tryk p& og hold afbryderen nede

i mindre end fire sekunder. Hvis
harddiskens lysdiode ikke lyser grent,
skal du derefter gere folgende:

1. Kontroller, at enheden er tilsluttet
et fungerende stromstik.

2. Abn l&get, og kontroller, at
afbryderen er tilsluttet korrekt
til systemkortet.

3. Kontroller, at begge
stremforsyningskabler er tilsluttet
korrekt til systemkortet.

4. Kontroller, at lysdioden 5 V_aux pé

systemkortet lyser. Hvis den lyser,
kan du tilslutte afbryderen igen.

5. Huvis lysdioden 5 V_aux pé
systemkortet ikke lyser, skal du
bruge en anden stramforsyning.

6. Udskift systemkortet.

www.hp.com
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Sikkerhed med adgangskode
og nulstilling af CMOS

Computeren understgtter adgangskodefunktioner, der kan oprettes
fra menuerne i computerens opsa@tningsprogram.

Computeren understgtter fglgende to adgangskodefunktioner, der oprettes
via menuerne i computerens ops@tningsprogram: Adgangskode

for ops@tning og adgangskode for start. Hvis der kun oprettes en
adgangskode for opsatning, kan enhver bruger fa adgang til alle
oplysningerne pa computeren undtagen computerens opsa&tningsprogram.
Hyvis du kun opretter en adgangskode for start, kan ingen fa adgang
til computerens opsatningsprogram og de gvrige oplysninger pa
computeren uden denne kode. Hvis du opretter begge adgangskoder,
er der kun adgang til computerens ops&tningsprogram med
adgangskoden for ops®tning.

Nar begge adgangskoder er aktiveret, kan adgangskoden for opsatning
bruges i stedet for adgangskoden for start til at tilsidesatte retten

til at logge pa computeren. Dette er en nyttig funktion for
netvaerksadministratoren.

Hyvis du glemmer adgangskoden til computeren, er der to mader,
hvorpa du kan rydde adgangskoden, s& du kan fa adgang til
oplysningerne pa computeren:

B Nulstilling af adgangskodejumperen

B Med knappen til rydning af CMOS

FORSIGTIG: Tryk pd CMOS-knappen for at nulstille vaerdierne i CMOS
til fabriksindstillingerne og slette de tilpassede oplysninger, herunder
adgangskoder, sporingsnumre og specielle indstillinger. Det er vigtigt

at sikkerhedskopiere computerens CMOS-indstillinger inden nulstilling

i tilfeelde af, at de skal bruges senere. Det er nemt at sikkerhedskopiere med
computerens opszetningsprogram. Se Vejledning til computeropsaetning
(F10) p& Dokumentation og diagnose-cd’en for at f& oplysninger om

sikkerhedskopiering af CMOS-indstillingerne.

Vejledning til fejlfinding
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Sikkerhed med adgangskode og nulstilling af CMOS

Nulstilling af adgangskodejumper

Fglg nedenstdende fremgangsméade for at deaktivere funktionerne
med adgangskode for opsatning eller start eller for at rydde
adgangskoderne helt.

1. Luk operativsystemet korrekt ned, sluk computeren og alle
tilsluttede enheder, og tag derefter netledningen ud af
stikkontakten.

2. Afbryd netledningen, og tryk pa afbryderen igen for at dreene
systemet for eventuel reststrgm.

ADVARSEL: Trzek ledningen ud of stikket, og lad de interne komponenter
kele of, fer du rerer dem, for at mindske risikoen for personskade p&
grund of elektrisk sted og/eller varme overflader.

FORSIGTIG: Stromforsyningen leverer altid spaending til systemkortet,
ndr computeren er tilsluttet ledningsnettet, selv ndr den er slukket.
Det kan beskadige systemet, hvis ledningen ikke traekkes ud of stikket.

FORSIGTIG: Statisk elekiricitet kan beskadige de elektroniske komponenter
i computeren eller ekstraudstyret. Inden disse procedurer pdbegyndes, skal
du sikre dig, at du har afladet dig selv for statisk elekiricitet ved at rere

en metalgenstand med jordforbindelse. Se i vejledningen Oplysninger

om sikkerhed og regulativer p& Dokumentation og diagnose-cd’en for

at 18 flere oplysninger.

3. Fjern computerens deekplade eller adgangspanel.

4. Find headeren og jumperen.

% Adgangskodejumperen er grgn, sd den er nem at genkende.
Se den illustrerede komponentoversigt til dit system for at finde
adgangskodejumperen og andre komponenter pa systemkortet.
Du kan hente en illustreret komponentoversigt pa webstedet
www.hp.com/support.

5. Tag jumperen vk fra ben 1 og 2. S@t jumperen pa enten ben
1 eller 2 (men ikke pa begge ben), sa den ikke bliver vaek.

6. S@t computerens dekplade eller adgangspanel pa igen.
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Sikkerhed med adgangskode og nulstilling af CMOS

7. Tilslut eksternt udstyr.

8. Sat stikket til computeren i, og teend for strgmmen.
Lad operativsystemet starte. Dette sletter de aktuelle
adgangskoder og deaktiverer funktionerne.

9. Gentag trin 1 til 4, og st adgangskodejumperen pa ben 1 og 2
igen, og gentag derefter trin 6 til 8 for at danne nye adgangskoder.
Opret de nye adgangskoder i computerens ops&@tningsprogram.
Se Vejledning til computeropscetning (F10) pa Dokumentation
og diagnose-cd’en for at fa en vejledning til computerens
ops&tningsprogram.

Rydning og nulstilling af CMOS

Computerens CMOS (konfigurationshukommelse) lagrer oplysninger
om adgangskoder samt oplysninger om computerens konfiguration.

Brug af CMOS-knappen

1. Sluk computeren og de eksterne enheder, og trek ledningen ud
af stikkontakten i veggen.

2. Afbryd tastatur, skerm og andet eksternt udstyr, der er tilsluttet
computeren.

ADVARSEL: Track ledningen ud of stikket, og lad de interne komponenter
kele af, fer du rerer dem, for at mindske risikoen for personskade p&
grund af elektrisk sted og/eller varme overflader.

FORSIGTIG: Stromforsyningen leverer altid spaending til systemkortet,
ndr computeren er tilsluttet ledningsnettet, selv nér den er slukket.
Det kan beskadige systemet, hvis ledningen ikke traekkes ud of stikket.

FORSIGTIG: Statisk elekiricitet kan beskadige de elektroniske komponenter
i computeren eller ekstraudstyret. Inden disse procedurer p&begyndes, skal
du sikre dig, at du har afladet dig selv for statisk elekiricitet ved at rere en
metalgenstand med jordforbindelse. Se vejledningen Oplysninger om
sikkerhed og regulativer p& Dokumentation og diagnose-cd’en for at f&
yderligere oplysninger.
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Sikkerhed med adgangskode og nulstilling af CMOS

3. Fjern computerens dekplade eller adgangspanel.

FORSIGTIG: Tryk p& CMOS-knappen for at nulstille veerdierne i CMOS
til fabriksindstillingerne og slette de tilpassede oplysninger, herunder
adgangskoder, sporingsnumre og specielle indstillinger. Det er vigtigt

at sikkerhedskopiere computerens CMOS-indstillinger inden nulstilling

i tilfeelde af, at de skal bruges senere. Det er nemt at sikkerhedskopiere med
computerens opsaetningsprogram. Se Vejledning til computeropsaetning
(F10) p8 Dokumentation og diagnose-cd’en for at f& oplysninger om
sikkerhedskopiering af CMOS-indstillingerne.

4. Find, tryk pa og hold CMOS-knappen nede i fem sekunder.

% Kontroller, at du har taget netledningen ud af stikket i veggen.
CMOS-knappen rydder ikke CMOS’en, hvis netledningen er
tilsluttet.

CMOS-knap

% Se den illustrerede komponentoversigt til dit system for at finde
CMOS-knappen og andre komponenter pa systemkortet.

5. Szt computerens dekplade eller adgangspanel pa igen.
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Sikkerhed med adgangskode og nulstilling af CMOS

AN

6. Tilslut de eksterne enheder igen.

7. Set stikket til computeren i, og teend for strgmmen.

Der vises POST-fejimeddelelser, nar CMOS er ryddet og efter genstart,
som informerer dig om, at der er sket @ndringer i konfigurationen.
Brug computerens ops@tningsprogram til at nulstille adgangskoder
og eventuelle s@rlige systemopsatninger tillige med dato og
klokkeslzt.

Se Vejledning til desktopadministration pa Dokumentation og
diagnose-cd’en for at fa flere oplysninger om genetablering af
adgangskoder. Se Vejledning i computeropscetning (F10) pa
Dokumentation og diagnose-cd’en for at fa flere oplysninger
om computerens ops&tning.

Brug af computerens opsatningsprogram
til at nulstille CMOS

Fgr du kan nulstille CMOS via computerens ops&@tningsprogram,
skal du fgrst abne menuerne i computerens ops&tningsprogram.

Tryk pa F10-tasten, nar computeropsatningsmeddelelsen vises
i nederste hgjre hjgrne af skeermen. Tryk eventuelt pa Enter for at
springe startskarmbilledet over.

Hvis du ikke trykker pa F10-tasten, nar meddelelsen vises, skal du
slukke computeren og teende igen for at fa adgang til hjelpeprogrammet.

Menuen for hjelpeprogrammer til computeropsatning giver fem
valgmuligheder: File, Storage, Security, Power og Advanced.

Indstil fgrst dato og klokkesl®t, og brug derefter piletasterne eller
tabulatortasten til at valge File > Set Defaults and Exit for

at nulstille CMOS til standardindstillingerne. Derved nulstilles
indstillingerne, herunder startreekkefglge og andre fabriksindstillinger.
Hardwaren opdateres imidlertid ikke igen.

Se Vejledning til desktopadministration pa Dokumentation og diagnose-
cd’en for at fa flere oplysninger om genetablering af adgangskoder.
Se Vejledning til computeropscetning (F10) pa Dokumentation og
diagnose-cd’en for at fa flere oplysninger om computerens ops&tning.

Vejledning til fejlfinding
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DPS (Drive Protection System)

DPS (Drive Protection System) er et diagnosticeringsverktgj, der
er indbygget i de harddiske, som er installeret pa nogle computere.
DPS er designet til at afhjelpe de diagnosticeringsproblemer, der
kan fgre til ugnsket udskiftning af harddiske.

Nar disse systemer bygges, testes hver harddisk ved hjzlp af DPS,
og en permanent fortegnelse over nggleoplysningerne skrives pa
drevet. Hver gang DPS kgres, skrives testresultaterne pa harddisken.
Serviceyderen bruger disse oplysninger til at afthjelpe de
diagnosticeringsproblemer, der gjorde det ngdvendigt at kgre
DPS-softwaren.

Kgrsel af DPS péavirker ikke programmer eller data, der er lagret

pa harddisken. Testen findes i harddiskens firmware og kan udfgres,
selv nar computeren ikke vil genstarte et operativsystem. Den tid,
det tager at udfgre testen, athenger af producenten og harddiskens
stgrrelse. I de fleste tilfelde varer testen cirka to minutter pr. GB.

DPS bgr bruges ved mistanke om et harddiskproblem. Hvis computeren
viser en meddelelse om SMART Hard Drive Detect Imminent Failure
(en alvorlig harddiskfejl), er der ingen grund til at kgre DPS. Du skal
i stedet sikkerhedskopiere oplysningerne pa harddisken og kontakte
en serviceyder for at fa en ny harddisk.
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DPS (Drive Protection System)

Adgang til DPS via computerens
opsatningsprogram

Hvis computeren ikke tender korrekt, skal du bruge computerens
ops@tningsprogram til at fa adgang til DPS-programmet.
Fglg fremgangsmaden nedenfor for at fa adgang til DPS:

1. Tend, eller genstart computeren.

2. Tryk pa F10-tasten, nar F10-ops@tningsmeddelelsen vises
nederst til hgjre pa skeermen.

Hvis du ikke trykker pa F10-tasten, nar meddelelsen vises, skal du
slukke computeren og teende igen for at fa adgang til hjaelpeprogrammet.

Menuen for hjelpeprogrammer til computerops@tning giver fem
valgmuligheder: File, Storage, Security, Power og Advanced.

3. Valg Storage > DPS Self-Test.

P4 skermen vises en liste over harddiske med DPS, der er
installeret pa computeren.

Hyvis der ikke er installeret harddiske med DPS-egenskaber, vises
indstillingen DPS Self-Test ikke pa skermen.

4. Velg den harddisk, der skal testes, og fglg vejledningen
pa skarmen for at gennemfgre testen.

Nar testen er udfgrt, vises én ud af fglgende tre meddelelser:
B Test Succeeded (testen er korrekt udfgrt). Afslutningskode 0.
B Test Aborted (testen blev afbrudt). Afslutningskode 1 eller 2.

B Test Failed (testen mislykkedes). Det anbefales at udskifte
disken. Afslutningskode 3 til 14.

Hyvis testen mislykkes, skal afslutningskoden noteres og rapporteres
til serviceyderen, sa du kan fa hjalp med diagnosticering af
computerproblemet.

c-2
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adgangskode
fjerne B—1
For opsatning B-1
funktioner B—1
nulstille jumper B-2
Opstart B-1
Adgangskode for ops@tning B-1
Adgangskode for opstart B—1
Adgangspaneler, fjerne 2—7

B

batteri, udskifte 2—6
bipkoder A-13

blinkende lysdioder A-13

C
cd-rom eller dvd-problemer 2—40
CMOS
afbryder B-1, B-3
rydde og nulstille B-3
sikkerhedskopiere B—1

dato- og klokkesl®tsvisning 2—6
diagnosticeringsprogram 1-1
disketteproblemer 2—12

DPS (Drive Protection System) C—1
Drevkodeproblemer 2—42
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Fejlkoder A-1

Full Boot A-1

funktionen Wake-on-LAN 2-34
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generelle problemer 2—-6

H
harddiskproblemer 2—15
hgrbare alarmer A—13
Hukommelse
Fejlkoder A—4, A-5
lgse problemer 2—38

Insight Diagnostics 1-1
internetadgangsproblemer 2—43
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Kundeservice 2-2, 247

L
Lydproblemer 2-25
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blinkende
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Netverksproblemer 2—34

nulstille
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CMOS B-1

numeriske koder A-2

Nyttige rad 2—4
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